ADAPT RC 2010

For
Design of Reinforced Concrete Floor Systems and Beam Frames

USER MANUAL

Vol1_0410_0-3

Copyright 2010
# LIST OF CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>OVERVIEW</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>GETTING STARTED</td>
<td></td>
<td>7</td>
</tr>
<tr>
<td>SIGN CONVENTION</td>
<td></td>
<td>11</td>
</tr>
<tr>
<td>PROGRAM DESCRIPTION</td>
<td></td>
<td>15</td>
</tr>
<tr>
<td>4.1</td>
<td>GENERAL</td>
<td>17</td>
</tr>
<tr>
<td>4.2</td>
<td>GEOMETRY</td>
<td>17</td>
</tr>
<tr>
<td>4.2.1</td>
<td>Cross-Sectional Geometry</td>
<td>17</td>
</tr>
<tr>
<td>4.2.2</td>
<td>Other Geometrical Features</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.1</td>
<td>Effective Width</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.2</td>
<td>Span Length</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.3</td>
<td>End-support Conditions</td>
<td>22</td>
</tr>
<tr>
<td>4.2.2.4</td>
<td>Interior Support Conditions</td>
<td>23</td>
</tr>
<tr>
<td>4.2.3</td>
<td>Customary Changes in Geometry of Beam/Slab</td>
<td>25</td>
</tr>
<tr>
<td>4.2.3.1</td>
<td>Drop Caps and Drop Panels for Slabs</td>
<td>26</td>
</tr>
<tr>
<td>4.2.3.2</td>
<td>Haunched Beams</td>
<td>28</td>
</tr>
<tr>
<td>4.2.3.3</td>
<td>Beams Normal (Transverse) to Direction of Frame</td>
<td>29</td>
</tr>
<tr>
<td>4.2.4</td>
<td>Column Geometry and End Conditions</td>
<td>31</td>
</tr>
<tr>
<td>4.2.5</td>
<td>Width of Support for Moment Reduction</td>
<td>32</td>
</tr>
<tr>
<td>4.2.6</td>
<td>Structural Modeling of Slabs</td>
<td>32</td>
</tr>
<tr>
<td>4.2.6.1</td>
<td>General</td>
<td>32</td>
</tr>
<tr>
<td>4.2.6.2</td>
<td>Tributary or Unit Strip Modeling</td>
<td>33</td>
</tr>
<tr>
<td>4.3</td>
<td>LOADING</td>
<td>36</td>
</tr>
<tr>
<td>4.3.1</td>
<td>Number of Loads</td>
<td>36</td>
</tr>
<tr>
<td>4.3.2</td>
<td>Classes and Types of Loading</td>
<td>36</td>
</tr>
<tr>
<td>4.3.2.1</td>
<td>Classes of Loading</td>
<td>36</td>
</tr>
<tr>
<td>4.3.2.2</td>
<td>Types of Loading</td>
<td>37</td>
</tr>
<tr>
<td>4.3.3</td>
<td>Skipping of Loads (Pattern Loading)</td>
<td>43</td>
</tr>
<tr>
<td>4.3.4</td>
<td>Load Combinations</td>
<td>44</td>
</tr>
<tr>
<td>4.4</td>
<td>DESIGN CAPABILITIES</td>
<td>44</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Definition of Terms</td>
<td>44</td>
</tr>
<tr>
<td>4.4.2</td>
<td>Analysis and Design Steps</td>
<td>45</td>
</tr>
<tr>
<td>4.4.2.1</td>
<td>Serviceability</td>
<td>45</td>
</tr>
<tr>
<td>4.4.2.2</td>
<td>Strength</td>
<td>45</td>
</tr>
<tr>
<td>4.5</td>
<td>INVESTIGATION CAPABILITIES</td>
<td>46</td>
</tr>
<tr>
<td>WORKSPACE</td>
<td></td>
<td>47</td>
</tr>
</tbody>
</table>
5. OVERVIEW .......................................................................................................... 49
5.1 THE MAIN PROGRAM WINDOW ........................................................................ 49
  5.1.1 Main Program Window Menu Items and Corresponding Tools .................. 50
    5.1.1.1 File Menu .................................................................................... 50
    5.1.1.2 Action Menu ............................................................................... 51
    5.1.1.3 View Menu .................................................................................. 51
    5.1.1.4 Options Menu .............................................................................. 52
    5.1.1.5 Window Menu ............................................................................. 53
    5.1.1.6 Help Menu .................................................................................. 53
5.2 ADAPT-RC INPUT SCREEN ............................................................................... 53
  5.2.1 ADAPT RC-Input Menu Items and Tools ................................................. 56
    5.2.1.1 File .............................................................................................. 56
    5.2.1.2 Project ......................................................................................... 56
    5.2.1.3 Geometry ..................................................................................... 56
    5.2.1.4 Loads ........................................................................................... 57
    5.2.1.5 Material ....................................................................................... 57
    5.2.1.6 Criteria ........................................................................................ 57
    5.2.1.7 Execute ........................................................................................ 57
    5.2.1.8 Tools ........................................................................................... 57
    5.2.1.9 Window ....................................................................................... 58
    5.2.1.10 Structure View ............................................................................ 58
    5.2.1.11 View Tools Toolbar .................................................................... 58

BASIC PROGRAM OPERATIONS .............................................................................. 61
6. OVERVIEW .......................................................................................................... 63
6.1 START A NEW PROJECT ................................................................................... 63
6.2 OPEN AN EXISTING PROJECT .......................................................................... 63
6.3 SAVE INPUT DATA ............................................................................................ 63
6.4 SAVE INPUT DATA AS DEFAULT ................................................................... 64
6.5 SELECT SYSTEM OF UNITS ............................................................................. 64
6.6 CONVERT SYSTEM OF UNITS ......................................................................... 65
6.7 SELECT DESIGN CODE ..................................................................................... 65

STRUCTURAL MODELING AND EXECUTION ..................................................... 67
7. OVERVIEW .......................................................................................................... 69
7.1 PROJECT INFORMATION .................................................................................. 69
  7.1.1 Specify General Project Information ......................................................... 69
  7.1.2 Specify Analysis and Design Options ........................................................ 71
7.2 GEOMETRY ......................................................................................................... 72
  7.2.1 Specify Span Geometry ............................................................................. 73
    7.2.1.1 Prismatic (Uniform) Spans ................................................................ 73
    7.2.1.2 Non-prismatic (non-uniform) spans .................................................. 75
7.2.2 Specifying Effective Flange Width ................................................................. 78
7.2.3 Specifying Geometry of Drop Cap and/or Transverse Beam .................. 79
7.2.4 Specifying Geometry of a Drop Panel ......................................................... 80
7.2.5 Specifying Support Geometry and Stiffness ............................................. 80
7.2.6 Specifying Support Boundary Conditions ................................................. 82

7.3 LOADS ............................................................................................................... 84
7.3.1 Specifying Dead, Live and Other loads ..................................................... 84
7.3.2 Specifying Lateral Loads ........................................................................... 86

7.4 MATERIAL ........................................................................................................... 87
7.4.1 Specifying Concrete Material .................................................................... 87
7.4.2 Specifying Reinforcement Material ............................................................. 88

7.5 CRITERIA ............................................................................................................. 89
7.5.1 Specifying Base Non-Prestressed Reinforcement ...................................... 89
7.5.2 Specifying Minimum Covers ..................................................................... 90
7.5.3 Specifying Minimum Bar Extension ............................................................ 90
7.5.4 Specifying Load Combinations .................................................................. 91
7.5.5 Specifying the Design Code ....................................................................... 92

7.6 EXECUTION ...................................................................................................... 93

7.7 INVESTIGATION DATA AND EXECUTION ..................................................... 93

VIEW/VALIDATE RESULTS .................................................................................. 95

8 OVERVIEW .......................................................................................................... 97
8.1 ADAPT-RC SUM SCREEN .............................................................................. 97
8.1.1 ADAPT-RC Sum Menu Items and Corresponding Tools .......................... 98
8.1.1.1 File menu ........................................................................................... 98
8.1.1.2 Graphs menu ..................................................................................... 99
8.1.1.3 Options menu .................................................................................... 101
8.1.1.4 Window menu ................................................................................... 101
8.1.1.5 Help menu ......................................................................................... 101
8.1.1.6 Summary Report ............................................................................... 101

REPORTS ............................................................................................................... 109
9 OVERVIEW ......................................................................................................... 111
9.1 REPORT GENERATOR SCREEN .................................................................... 111
9.2 HOW TO CREATE REPORT ........................................................................... 112
9.3 DESCRIPTION OF REPORT SECTIONS ...................................................... 113
9.3.1 Report Cover Page .................................................................................... 114
9.3.2 Table of Contents ..................................................................................... 115
9.3.3 Concise Report .......................................................................................... 118
9.3.4 Compact Report ....................................................................................... 122
9.3.4.1 Section 1- User Specified General Analysis and Design Parameters .. 123
9.3.4.2 Section 2: Input Geometry ................................................................. 124
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.3.3</td>
<td>Section 3: Input Applied Loading</td>
<td>129</td>
</tr>
<tr>
<td>9.3.4</td>
<td>Section 4: Calculated Section Properties</td>
<td>130</td>
</tr>
<tr>
<td>9.3.5</td>
<td>Section 5: Moments, Shears and Reactions</td>
<td>132</td>
</tr>
<tr>
<td>9.3.6</td>
<td>Section 6: Moments Reduced to Face of Support</td>
<td>134</td>
</tr>
<tr>
<td>9.3.7</td>
<td>Section 8: Factored Moments and Reactions Envelope</td>
<td>135</td>
</tr>
<tr>
<td>9.3.8</td>
<td>Section 9: Factored Lateral Moments Envelope</td>
<td>136</td>
</tr>
<tr>
<td>9.3.9</td>
<td>Section 10: Mild Steel - No Redistribution</td>
<td>137</td>
</tr>
<tr>
<td>9.3.10</td>
<td>Section 11: Mild Steel –Redistributed</td>
<td>140</td>
</tr>
<tr>
<td>9.3.11</td>
<td>Section 12: Shear Reinforcement</td>
<td>140</td>
</tr>
<tr>
<td>9.3.12</td>
<td>Section 13: Punching Shear Reinforcement</td>
<td>141</td>
</tr>
<tr>
<td>9.3.13</td>
<td>Section 14: Deflections</td>
<td>142</td>
</tr>
<tr>
<td>9.3.14</td>
<td>Section 16: Unbalanced Moment Reinforcement</td>
<td>143</td>
</tr>
<tr>
<td>9.3.5</td>
<td>Detailed Report</td>
<td>144</td>
</tr>
<tr>
<td>9.3.5.1</td>
<td>Section 23: Detailed Moments</td>
<td>144</td>
</tr>
<tr>
<td>9.3.5.2</td>
<td>Section 24: Detailed Shears</td>
<td>144</td>
</tr>
<tr>
<td>9.3.5.3</td>
<td>Section 25: Factored Moments and Reactions</td>
<td>145</td>
</tr>
<tr>
<td>9.3.5.6</td>
<td>Section 26: Factored Lateral Moments</td>
<td>145</td>
</tr>
<tr>
<td>9.3.5.7</td>
<td>Section 29: Detailed Rebar</td>
<td>146</td>
</tr>
<tr>
<td>9.3.5.8</td>
<td>Section 30: Punching Shear Reinforcement</td>
<td>146</td>
</tr>
<tr>
<td>9.3.5.9</td>
<td>Section 32: Unbalanced Moment Reinforcement</td>
<td>147</td>
</tr>
<tr>
<td>9.3.5.10</td>
<td>Section 33: Investigation Mode</td>
<td>147</td>
</tr>
<tr>
<td>9.3.6</td>
<td>Graphical Report</td>
<td>148</td>
</tr>
<tr>
<td>9.3.6.1</td>
<td>Deflection</td>
<td>148</td>
</tr>
<tr>
<td>9.3.6.2</td>
<td>Load Cases</td>
<td>148</td>
</tr>
</tbody>
</table>
Chapter 1

OVERVIEW
ADAPT-RC is a powerful and sophisticated computer program for the analysis and design of one-way or two-way reinforced concrete floor systems and beams. It is based on a single-story frame analysis with upper and lower columns or walls. For two-way floor systems the Equivalent Frame Method (EFM) of ACI can be used as an option. ADAPT-RC is a Windows-based program.

The following lists the some of the features of the program.

- ADAPT-RC treats multi-span continuous slab/plate and beam frames with or without cantilevers at their ends.

- In addition to drop caps, ADAPT-RC allows drop panels of different sizes to be specified for different spans. Having a general one-story frame analysis module for variable sections, ADAPT-RC can accurately model a wide range of drop cap/panel geometries. Locally thickened slabs, also referred to as slab bands, are handled as an integral part of the slab/support structure.

- The slab region/beam may be supported by walls, beams, or columns with different connection details such as clamped, rotationally free, and more.

- ADAPT-RC fully incorporates the Equivalent Frame Method as described in ACI-318 with no simplifications.

- In addition to the capability to handle the conventional configurations of column capitals and drop panels, ADAPT-RC allows the user to define a wide range of cross-sectional shapes. The software allows for the cross-section of the member to change along the length of a span, with abrupt steps, at the top, bottom, or both.

- For flanged beams, you can either select the software’s built-in effective width computation, based on ACI-318, or input a user-defined alternative effective width.

- Using the geometry of the structural model input and the user-specified material density, the program calculates the selfweight loading of the structure for combination with other loads. The calculated values of the selfweight are reported in the program’s output.

- Uniform, line, partial, triangle, variable, trapezoidal, concentrated loads and moments may be specified in practically unlimited numbers and variations.
• All three systems of units, the American customary units (ft-lb.), SI units (mm, Newton), and the MKS unit (m, kg), can be executed from the same copy of the software. Also, all the different codes are integrated into a single version. Data generated in one system of units can be converted into another system by the program.

• You can either edit the factory-set, or define your own default values for input of data, while retaining the option to revert to factory-set default values if you so choose.

• Input to ADAPT-RC is by means of a user-friendly, free-format, context-sensitive, full-screen input editor. The user may freely browse through, view, and modify the input prior to execution or saving of data.

• ADAPT-RC performs a thorough strength analysis and design and determines any mild reinforcement that may be necessary to meet the ultimate strength limit conditions both in bending and shear.

• Other code requirements, such as the minimum reinforcement requirements, are also checked and a listing of the reinforcement based on different criteria is reported.

• Bar sizes and lengths are selected and reported both in a graphical and tabulator format, ready to be entered on the structural drawings.

• The punching shear option checks the adequacy of the column caps as well as the immediate slab/drop panel region beyond the cap and, if required provides the punching shear reinforcements based on the selected code provisions. For one-way slabs and beams, a one-way shear analysis is carried out. Shear reinforcement is calculated and the stirrup requirements are given.

• ADAPT-RC has an “Investigation Mode” that allows the users to forecast the effects of moment demand, as well as provided steel for the given geometry, material and loading of the design. There are three analysis options available. The first option permits the user to input the provided steel at 1/20th points of the span as well as the faces of support. Based on the input data, ADAPT-RC calculates the moment capacity. The second option applies the design loading along with the user defined provided steel to calculate the demand versus the capacity. The final option allows the user to input the demand moment as well as the provided steel. ADAPT-RC then calculates the moment capacities.
The geometry of the structural model can be viewed on the screen in a three-dimensional space along with the input screen. The capability to rotate, pan, zoom and view the model allows the user to examine the structure in detail prior to the execution of the program. Errors in data entry or modeling are readily detected when user’s input is displayed on the computer screen. Hard copies of the graphical display of the structural model can be readily obtained.

ADAPT-RC uses the detailed analysis scheme throughout its operation. This scheme is based on 1/20th point values along each span, in addition to the face-of-support and other sections with change in geometry. However, to retain the simplicity of presentation of the report, in addition to the optional 1/20th point reports, a summary of the solution is compiled for the left, center and right of each span.

In addition to graphical reports, the outcome of the analysis and design is composed into a clear text file that can be viewed, edited and printed by you. The content and extent of the report can be controlled by you through a user-friendly menu. The result may be compiled in several formats, such as concise, compact and detailed, thus saving lengthy printouts if only the critical data are sought.

It is also possible to generate a one-page graphical summary report that extracts and incorporates all important design information in an easy-to-interpret format. The report may also be exported as a DXF file for incorporation into construction documents.

The graphical display option of ADAPT-RC provides a vivid exposition of the distribution of calculated values along the entire structure or for its selected members. The display includes moments, shears, deflections, and reinforcement required/provided. Each graph may be printed or exported as a .bmp or a metafile.

ADAPT-RC input data is stored in a single file with the .ADB extension. However, the program is also backward compatible with input generated by earlier Windows versions of the program.
ADAPT-RC is integrated into the ADAPT-Builder software suite. Structural models generated using the Modeler module of the Builder suite can automatically be transferred to ADAPT-RC for analysis and design. This capability provides a seamless link between the Finite Element Method of ADAPT-Builder and ADAPT-RC.
Chapter 2

GETTING STARTED
Installation:

1. Install the hardware Key (dongle) by inserting it into a USB or parallel port. If a printer is connected to the parallel port, the Key can be sandwiched between the printer cable and the computer parallel port. The insertion of the Key does not impact the normal operation of your computer.

2. Invoke the executable file on the program CD. An installation program will open and provide further instructions. Follow the screen instructions until setup is complete.

Execution:

1. Open the ADAPT-RC program by double-clicking on the icon on your desktop or navigating through your START menu.

2. To test the computer environment for compatibility with ADAPT software, select Open from the File menu and select the example MNL5-2.ADB in the Examples subdirectory. This test example is in US customary units. Use this example to verify that the program runs. Execute the program. After the execution stops, you can view the results.
Chapter 3

SIGN CONVENTION
The following is the sign convention used in ADAPT-RC.

**Applied loads**
Downward loads and counterclockwise moments are considered positive (Fig. 3.1 (a)).

**Span Actions**
Counterclockwise shear is considered positive.
Bending moment is considered positive if it causes tension at the bottom. Fig. 3.1 (b)

**Column actions**
Counterclockwise column moments are considered positive Fig. 3.1 (d).

Positive direction of frame as well as definition of right and left tributary region is defined as shown in Figure 3.1 (c).

**FIGURE 3-1 SIGN CONVENTION**
Chapter 4

PROGRAM DESCRIPTION
4.1 GENERAL

The following is an overview of the scope and capability of ADAPT-RC. For detailed information on its operation, including input generation, and execution refer to Chapter 6 of this manual. For the theoretical background to the calculations performed by the program refer to Theory Chapter in Volume 11.

4.2 GEOMETRY

4.2.1 Cross-Sectional Geometry

ADAPT-RC handles beams, one-way slabs and two-way floor systems. The two-way floor system can be solid slab, waffle or joist construction. Spans may be prismatic or nonprismatic.

The treatment of slabs in ADAPT-RC is based on a single story slab and/or beam frame modeling with columns/walls extending below and above the slab/beam. The frame consists of one line of column supports along with the associated tributary of the slab. A simple example of floor modeling is shown in Fig. 4.2-1. A floor system (Fig. 4.2-2) consists of the essentially horizontal diaphragm, which spans the vertical supports and is intended to provide a surface for support of gravity loading. Beams, changes in the slab thickness, offsets (steps) above and below the slab, and openings are common, essential features of a floor system.

For purpose of design, regions of the slab are commonly designated by specific names. A support line is a hypothetical line defined by the designer that joins adjacent supports (Fig. 4.2-3). A bay is the slab area bounded by two adjacent support lines. A panel is a portion of a slab enclosed by four adjacent columns.

A design strip consists of a line-of-support together with a portion of the slab on each side of the line-of-support, called the tributary (Fig. 4.2-4). Through extensive modeling features integrated into ADAPT-RC, complex beam and slab geometries with nonstandard support conditions can be readily modeled. The ACI recommended equivalent frame modeling is built into ADAPT-RC as an option of slab frame analysis.

The geometry of the structural model includes the cross-sectional definition of the slab/beam for each span, span length, and the details of the slab/beam supports.
Each span may be composed of a uniform cross-section, in which case the span is referred to as **prismatic**, or it may be composed of a number of segments, each having a different cross-sectional geometry, in which case that span is referred to as **nonprismatic**. A **segment** is a portion of span with uniform cross section and in the direction of the frame being analyzed.

Each segment of the span can be assigned a cross-sectional geometry from the library of ADAPT-RC. The list of geometries currently in the ADAPT-RC library is shown in **Fig. 4.2-5**.
In order to facilitate input of common geometries, two input modes are included in ADAPT-RC. One is for input of common geometries, such as slabs with or without drop caps and drop panels. The other is for input of highly irregular slab or beam geometries.

For the common geometries, the input is intuitive. That is to say, the user inputs span length, cap and drop dimensions and particulars of features that occur in common geometries. This mode of input is referred to as the **customary** input. Furthermore, the customary mode of input allows the user to enter a representative strip of slab, referred to as **unit strip**. This feature is described in more detail in another section of this chapter, **Structural Modeling of Slabs**.
DEFINITION OF FRAME LINE, BAY AND PANEL

PARTIAL PLAN
SUPPORT LINE TRIBUTARY OF DESIGN STRIP B

FIGURE 4.2-3

FIGURE 4.2-4
For the unusual case, the user subdivides the span into segments, each having a uniform cross-section. The geometry of each segment is then entered independently. This mode of input is referred to as segmented input. Segmented input allows the user to specify steps, openings, transverse beams and other nonuniform conditions.

In two-way slab construction, where the drop panels of one support extend and merge with the drop panels of the next support in the same span, a cross-sectional condition referred to as Type 2 in Fig. 4.2-5 is used. This geometry is referred to as slab band, or wide shallow beam. A slab band is treated differently from a regular beam. In the former the total width of the slab (tributary) is considered effective in resisting the loads. This is in
accordance with the equivalent frame concept. However, for a beam, the effective width in many cases is less than the beam's tributary, as described in the next section.

The information on the geometry of drop caps, drop panels, or beam haunches is defined and input independently from slab/beam geometry. The slab/beam geometry covers only the typical region of a span, commonly its central region.

4.2.2 Other Geometrical Features

4.2.2.1 Effective Width

In flanged beam design, often it becomes necessary to assign a smaller width than the flange tributary (effective width) to act with the beam stem in resisting the flexure of the beam. In ADAPT-RC, according to the user's choice, the effective width of a flange is either calculated using ACI recommendations, or it is input by the user. For inverted L- or T-sections, the effective width is applied to the bottom flange. For an I-section with a wide flange, the effective width is calculated for both the top and the bottom flanges. The smaller of the two is selected and applied to the entire section.

4.2.2.2 Span Length

Span length is measured from and to support centerlines. Support centerlines are also referred to as system lines or frame lines.

4.2.2.3 End-support Conditions

The end-support is defined as the last support of the slab/beam at its left or right end. Each slab/beam, therefore, has two end supports. Fig. 4.2-6 shows the end support at left, together with a partial elevation of the end-span. Three conditions for end-supports, as described below, are implemented in ADAPT-RC:

**Cantilever Support**: Occurs when part of the span extends beyond the end support. Again, the end support may or may not be a moment connection with its wall/column support.
**Regular Support**: Occurs when the slab/beam terminates over a wall, column or beam. The question of whether the support can develop a bending moment or not is treated elsewhere in the description of support/slab connections. At a regular support the slab/beam is free to rotate. The magnitude of rotation, however, is controlled by the stiffness of the column/wall support. In the terminology of ADAPT-RC and for data input, this condition is termed *rotationally not fixed* to distinguish it from the condition of full fixity (zero angle of rotation), which is called *rotationally fixed*.

Since the two end supports are treated independently, data for each is input separately.

**4.2.2.4 Interior Support Conditions**

The different interior support conditions that can be modeled by ADAPT-RC are shown in Fig. 4.2-7. Observe that for all the conditions shown, the deflection at the centerline of support (system line) is considered to be zero. The shortening of columns or the sinking of supports is not included in the formulation. The differences between the formulations of the support options illustrated in the diagram lie in:
• The rotational stiffness of the supporting column or wall.
• The torsional stiffness of the beam transverse to the direction of the frame.
• The width of support in the direction of the frame.

Support conditions (a), (b) and (c) represent full connection at the slab/beam junction. In these cases moment transfer between the slab/beam and the column is based on the column’s stiffness. The reduction of the moment peak at the column centerline is
governed, among other factors, by the width of column in the direction of the frame.

The wall support condition (d) provides a finite support width that result in flattening of the moment peak at the support centerline. Whether or not a moment will also be transferred to the support is decided by the user, and affected through the input data from the construction details of the joint.

For the beam support condition (e) of the diagram, only the torsional stiffness associated with the beam cross-section and its length affect the solution for two-way systems. This type of support is referred to as transverse beam support and is within the scope of ADAPT-RC.

In one-way slabs, the transverse beam acts as a thickening of the slab at its supports. A one-way slab, by definition, deflects in strips of identical shape. As a result, the beam will not be subject to torsion. The increased thickness due to the beam, however, affects the distribution of moment in the slab. The slab may be designed for the moment at the face of the transverse beam. ADAPT-RC, at the user’s option, accounts for the added stiffness of the transverse beam and can reduce the design moment to the face of the beam for the design of the slab.

Support type (f) is basically the same as the wall support shown in (d), but is constructed to minimize generation of forces in the direction of the frame due to shortening of the slab/beam.

A knife edge support as shown in (g) is one for which no moment is transferred between the support and the slab/beam. In this case the system line moments calculated from the analysis are not reduced for design.

4.2.3 Customary Changes in Geometry of Beam/Slab

ADAPT-RC can handle both prismatic and nonprismatic slabs. A nonprismatic member is defined as one in which the cross-section of the member (slab or beam) changes between two adjacent supports. A haunched beam and a slab with drop caps or panels are examples of nonprismatic members.

All details of changes in the cross-sectional geometry of a member are
rigorously accounted for in the formulation of ADAPT-RC. There are no ADAPT-RC approximations to the structural model. This section describes the scope of the geometries covered by ADAPT-RC and modeling guidelines for common changes in geometry.

4.2.3.1 Drop Caps and Drop Panels for Slabs

Fig. 4.2-8 shows the elements of the geometry at an interior support provided with a Drop Cap and Drop Panel. Drop caps and drop panels are also referred to as step 1 and step 2 of the geometry change.

**FIGURE 4.2-8**

(a) PARTIAL PLAN OF SLAB OVER AN INTERIOR COLUMN

(b) SECTION THROUGH COLUMN/SLAB JUNCTION

DEFINITION OF GEOMETRY AND PARAMETERS AS USED IN THE "GEOMETRY" INPUT FILE OF ADAPT. NOTE: SUFFIX L-LEFT, R-RIGHT

GEOMETRY OF DROP CAP/PANEL
When drop caps and/or drop panels are present, the span is treated as a nonprismatic member. The added stiffness due to caps and panels is included in the analysis.

Several examples of column/slab junction geometries are given in Fig. 4.2-9.

Any support can have a drop cap and/or a drop panel independent of the remaining supports. The caps and panels at different supports need not have the same geometry. It becomes necessary,
therefore, to define fully the drop cap and panel geometry at all supports. To facilitate the input routine, in particular when repeated geometries are used, the program is provided with a number of default options.

It is not necessary to have stepped geometries on both sides of a support. For each support, the total depth at step 1 (parameter CAPT in Fig. 4.2-8) must be larger than or equal to the thickness at step 2 (DROPTL, DROPTR). Either the length or width of step 2, or both, shall be larger than the corresponding values of step 1. In other words, it is assumed that as midspan is approached from the support, the depth of each succeeding step reduces, whereas its width and length (the horizontal dimensions) may or may not increase. If this assumption does not apply to the problem at hand, the general nonprismatic (segmented) input option must be used.

4.2.3.2 Haunched Beams

Haunched beams are modeled using segments to represent distinct steps. Each span can have a maximum of seven segments; normally three steps are used for each haunch. The user determines the step sizes and locations. Fig. 4.2-10 (a) illustrates an example of a haunched beam with sloping faces. Fig. 4.2-10(b) demonstrates how to model it.
4.2.3.3 Beams Normal (Transverse) to Direction of Frame

Fig. 4.2-11 shows beams normal to the direction of the modeled frame either (a) without, or (b) in conjunction with beams in direction of the frame.

In case (a), where the existing beams are all in the transverse direction, the beams may be modeled as “transverse beams,” when
using conventional input, or as a “segment,” when using segmented input.

In the case where beams extend in both directions, such as (b) in Fig. 4.2-11, the following procedure is used. The beam in the direction of the frame is considered as a **TYPE 2** section (see Fig. 4.2-5), and the beams in the transverse direction as **transverse beams**, or an independent **segment**.

Note that in data preparation, if the **transverse beam** option is selected, the beam is assumed to extend the entire tributary of the member (Fig. 4.2-12). But, if the **segmented** input option is used, the extent of the beam in the transverse direction is defined by the user.

**Fig. 4.2-12** identifies the frame line on gridline 5. As previously stated, the longitudinal beam (designated ABDC) in the first span must be modeled as a Type 2 section. For simplicity, use the
customary input generation library provided in the ADAPT-RC. The transverse beam is then entered with the following particulars:

Width to the left = GO  
Width to the right = OH  
Depth = Depth of beam  
Cap depth = Depth of beam (including slab)

### 4.2.4 Column Geometry and End Conditions

The connection of a column at its ends is described with the **Column Boundary Conditions** and is referenced in the ADAPT-RC output as **CBC**. ADAPT-RC treats four column boundary conditions as illustrated in **Fig. 4.2-13**. The conditions shown in the figure are equally applicable to wall supports, or a simple support as indicated at gridline A in the figure. These conditions are:

<table>
<thead>
<tr>
<th>CODE</th>
<th>CONDITION</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Standard; fixed at both ends</td>
</tr>
<tr>
<td>2</td>
<td>Hinged at near end, fixed or hinged at far end</td>
</tr>
<tr>
<td>3</td>
<td>Fixed at near end, hinged at far end</td>
</tr>
<tr>
<td>4</td>
<td>Fixed at near end, roller with rotational fixity at far end</td>
</tr>
</tbody>
</table>

![COLUMN BOUNDARY CONDITIONS](image)

**FIGURE 4.2-13**

In describing the geometry of a column or wall support, the following terminology is used:
- **Column/wall depth (D):**
  Dimension of support parallel to direction of frame.

- **Column/wall width (B):**
  Dimension of support perpendicular to direction of frame.

- **Simple support:**
  A simple support as shown at gridline A may be modeled using boundary condition 2, with a non-zero column height. A finite depth (D) can be specified to take advantage of the actual support width in reducing the system line bending moment to the face of support. It is recommended that the actual support width (B) be specified if the punching shear calculation option is invoked. By doing so, the reduction of moment to the face of support and punching shear calculations can take place without transferring a moment to the support.

For the purposes of analysis and design, circular columns are transformed by ADAPT-RC into square columns having the same cross-sectional area.

### 4.2.5 Width of Support for Moment Reduction

The analysis of ADAPT-RC is based on centerline moments (moments at the center of the joints). Moments can be reduced to the face of the supporting column or beam by selecting the **Reduce moment to face-of-support** option during data input. For column-supported slabs and beams, the support width is typically D, the dimensions of the column in the direction of the frame. In one-way slab systems, the width of the beam is typically used as the support width for the slab model. Note that the support width is used only to determine moment reduction; it has no effect on support fixity. **Figure 4.2-14** shows the support width of several common conditions.

### 4.2.6 Structural Modeling of Slabs

#### 4.2.6.1 General

This section describes options in modeling slab geometry. The geometry consists of a slab's cross-sectional shape at its midspan, total width (tributary), depth and other parameters as given earlier in this chapter.

Two schemes may be used for ADAPT-RC in modeling a slab.
The first scheme is called **Tributary** input, the second **Unit strip** input. Both schemes yield the same results. The selection is based on the preference of the user and the specific requirements of the structure. Once a scheme is selected, the input should be consistent with that selection throughout the data.

### 4.2.6.2 Tributary or Unit Strip Modeling

The tributary is composed of a region to the left and a region to the right of the frame line (Fig. 4.12-15). The sum of the left and right tributaries is called *total tributary*. The total tributary can vary within each span and from span to span.

**Left Tributary**: The portion of the tributary width that falls to the *left of the frame line* of a structural model. Fig. 4.2-16 defines the terms *left* and frame or system line in the context of the ADAPT-RC program. See also Fig. 4.2-16 for an example of ADAPT-RC’s point of reference in defining “Left” and “Right”.

---

**FIGURE 4.2-14**

SUPPORT WIDTHS (SW) FOR REDUCTION OF MOMENTS TO FACE OF SUPPORT
Right Tributary: This portion is analogous to the left tributary.

Unit Strip: A unit strip is an imaginary strip parallel to the span with a width equal to or less than the total tributary. The concept of unit strip is introduced to assist the user in data input and evaluation of output results. Although the unit strip width is typically 12 in. or 1000 mm, any reasonable value may be used. The unit width has no affect on the analysis as long as the total tributary width is modeled correctly. Users will get the same results with both methods.

Unit strip modeling (Fig 4.2-15). In unit strip modeling, the tributary is modeled by specifying a unit strip width as the ‘b’ dimension along with the width multiplier, left and right multipliers. The width multipliers (−M and M−>) indicate the number of times the unit strip needs to be multiplied to cover the left and right tributaries. The multipliers need not be whole numbers. If the total tributary is modeled as one strip, the sum of left and right multipliers must add up to one.
**Tributary Modeling:** In tributary modeling, the total tributary width is entered as the “b” dimension. The width multipliers (<-M and M->) are used to indicate how much of the tributary falls on either side of the frame line. The sum of the left and right multipliers should be one..

**Example:** Model the following tributary using A) unit strip method B) tributary method.

- Total tributary = 300 in.
- Left tributary = 180 in.
- Right tributary = 120 in.

**A) Unit strip method:**

\[ b = 12 \text{ in.} \quad <-M = 15 \quad M-> = 10 \]

Total width = Left tributary + Right tributary =
\[ 12 \times 15 + 12 \times 10 = 180 + 120 = 300 \text{ in.} \]

**B) Tributary method:**

\[ b = 300 \text{ in.} \quad <-M = 0.60 \quad M-> = 0.40 \]

Total width = Left tributary + Right tributary =
\[ 300 \times 0.60 + 300 \times 0.40 = 180 + 120 = 300 \text{ in} \]

---

**FIGURE 4.2-16**

**DIRECTIONS OF VIEW AND DEFINITION OF "LEFT" AND "RIGHT"**
In the case of slabs with drop caps, or slabs with drop caps and drop panels, the actual strips are not all identical in cross-sectional geometry. The program recognizes and allows for changes in geometry across the width of the span. Corrections necessary over the drop cap and drop panel regions are automatically implemented by the program from the drop cap and drop panel data.

4.3 LOADING

The loading applied to the structure, such as selfweight, superimposed dead loading, live loading and investigation loading, are discussed in this section.

4.3.1 Number of Loads

Each span may be specified to have several load entries. The number of different loads on any span, as well as the number of total loads which may be specified for the entire frame, are unlimited for practical purposes.

4.3.2 Classes and Types of Loading

4.3.2.1 Classes of Loading

Five classes of loading are treated, namely: (i) Selfweight (SW), (ii) Superimposed Dead Load (SDL), (iii) Live Load (LL), (iv) Other user defined Load case, and (v) Lateral Loading.

Selfweight: The program has the option of calculating the selfweight of the structure automatically from its geometry and unit weight. The selfweight computation of ADAPT-RC is precise. The weight of each segment of span is computed based on the volume of the respective segment. If you haven’t selected the option to calculate automatically, you can enter selfweight as independent.

Superimposed Dead Loading can be entered as independent from selfweight. In this case the user has an option to define different load factors for superimposed and selfweight.

Live Loading is entered as independent from the dead load entries. These loadings need not be specified for obtaining a solution.
Other Loading may be any loading that user applies on the structure. Internally the program doesn’t calculate creep effects for this loading and doesn’t skip it.

Lateral Loading is entered as concentrated moment acting at each face of support. The detail explanation about the treatment of lateral loads is given in Chapter 5 of the manual.

4.3.2.2 Types of Loading

Eight types of loading are covered by ADAPT-RC, namely:

- **Uniformly** distributed loading over the entire surface of a span (L-U).
- **Concentrated** loading at a given distance along a span (L-C).
- **Partial uniform** loading covering specific portions of a span surface (L-P).
- **Applied moment** at a given distance along a span (L-M).
- **Line** loading along a portion or the entire length of a span (L-L).
- **Triangle** loading along a portion or the entire length of a span (T-R).
- **Variable** loading along a portion or the entire length of a span (T-V).
- **Trapezoidal** loading along a portion or the entire length of a span (T-Z).

Other loading distributions should be modeled as a combination of the preceding eight types. The loading types are shown in Fig. 4.3-1 acting in their respective positive directions. The positive direction of line loading is the same as partial uniform loading.

For further illustration, consider Fig. 4.3-2, which shows the plan and elevation of an irregular, two-span frame. In addition to selfweight, the frame is subject to a uniform live loading. In ADAPT-RC a uniform loading is assumed to be distributed uniformly over the entire uppermost **surface** of the member with a constant intensity per unit area. However, in the case of inverted T-sections or I-sections, ADAPT-RC distributes the uniform loading over the larger of the two surface areas. The two-span structure includes other loads as shown in part (a) Fig. 4.3-3.
ADAPT-RC automatically calculates and generates the frame loadings from minimum user input. The outcome of ADAPT-RC's loading computations is listed in the output for the user's record or verification. For the benefit of the interested user, by way of an example, the following additional details are presented.
Selfweight is calculated from the geometry of the member. Since the tributary as well as thickness of members vary, the selfweight will result in a distribution marked with the encircled 1 in the diagram.

Note that where the tributary of a slab changes, the selfweight also changes.
Uniform live loading is applied over the surface area. But, because the surface area itself has a nonuniform tributary, the total uniform loading will result in a nonuniform distribution along the member (loading marked 2). The user makes only one entry for uniform loading. ADAPT-RC calculates the respective frame loading, which may consist of several values due to changes in tributary.

Consider the added uniform loading over the first cantilever (marked 3). Since the loading covers the entire length of the member, it is regarded as uniform. The same loading that extends to span 1, but
covers only a portion to conform with the definition of Fig. 4.3-1 of the length of span 1 (marked 4), is defined as partial loading.

Concentrated loading and moments act at specific locations along a span. Note that the position of these actions transverse to the direction of frame does not enter the computation (loadings circled 7 and 8 in Fig. 4.3-3) in the diagram.
Line loading refers to superimposed dead, live, or other loading. It is of uniform magnitude in direction of span (loadings circled 5 and 6 in the Fig. 4.3-3). The line loading is not affected by the surface geometry of the member.

The difference between partial and line loading is illustrated in Fig. 4.3-4.
4.3.3 Skipping of Loads (Pattern Loading)

Skipping of loading, or pattern loading, is limited to live loads, except for the British version of ADAPT-RC in which a proportion of dead loading is also skipped.

If load skipping is selected by the user, the program applies the load selectively on various spans in order to obtain the maximum and minimum moments and shears at each 20th point along each span.

In the general case, six patterns of loading, as illustrated in Fig. 4.3-5 are necessary to consider, in order to obtain critical values.

![Fig. 4.3-5](image)

Note that in skipped loading, for each loaded span, the entire live loading specified for that span is considered active simultaneously. In other words, if a given span has 10 live loads, in the loaded condition of that span all the 10 loads are assumed present.

A Skip Factor can be selected by the user if so desired. The skip factor is the factor by which the patterned loading is multiplied. Commonly, a skip
factor of 1 or less is assumed. Note that the skip factor is applied only to load patterns 2 through 6 of Fig. 4.3-5. The condition of load on all spans is implemented without a factor. That is to say, the load factor for pattern 1 is considered as 1, regardless of the user's entry.

4.3.4 Load Combinations

For the combinations of load cases, the critical values of moments and shears at each 20th point and the reactions are each multiplied by a load factor and combined to obtain the respective maximum and minimum values. Each version of ADAPT-RC has, as a default, the related, code-specified factors. However, the user has the option to override the code factors by entering a different load combination.

4.4 DESIGN CAPABILITIES

4.4.1 Definition of Terms

In the context of the present work the following words are used with the emphasis described herein:

Analysis is defined as the algorithm and sequence of steps leading to the determination of sectional actions (moments, shears), stresses and deflections, due to each and all of the loads on the structure. The analysis is based strictly on applying the known laws of statics and theorems of solid body mechanics to the structural model selected. Any deviations from the commonly used laws and theorems, such as code simplifications (if employed by ADAPT-RC), are clearly defined in this manual.

Design consists of:

- Adjustments and Redistribution of moments due to finite dimensions of the structure and post-elastic reserve in Strength;
- Load Factors and the Combination of Actions (moments, shears) to obtain the Design Moments, Design Shears, (collectively referred to as design actions, or Factored actions);
- Evaluation of the Ultimate Strength of the sections and determination of the required Mild Reinforcing; and
- Estimate of deflections beyond the elastic limit.
4.4.2 Analysis and Design Steps

Based on current codes, each structure is to be analyzed and designed to meet or exceed the stipulated code requirements for two conditions, namely Serviceability and Strength.

4.4.2.1 Serviceability

*Serviceability* means that the structure should satisfactorily perform its required function during the in-service condition. When applied to a reinforced concrete structure this is translated to mean:

- Deflections should be acceptable.
- Limiting crack size by providing a minimum amount of mild reinforcement over the supports and at midspans; ensuring durability by limiting cracks and the penetration of moisture and water.

ADAPT-RC checks for deflection and minimum reinforcement.

4.4.2.2 Strength

*Strength* check establishes that the structure designed has a minimum code specified margin of safety against collapse. To this end, factored shears and moments (also referred to as design shears and moments) are calculated from the serviceability actions and checked against the strength formulas. If a section is found to be inadequate, mild reinforcement is added to meet the required strength. In some cases the analysis has to be repeated using larger cross-sections.

Using the previously described input parameters, ADAPT-RC calculates all moment rebar and shear reinforcing requirements for the slab system. The required rebar is calculated at 1/20th points in each span, as well as each face of support, if desired. Rebar amounts are based upon code specified criteria for all strength and service requirements applicable to the slab system in question.

The program will also calculate the total number and length of bars to be placed at each location in the slab, based upon user-specified bar sizes, inflection points and code criteria. Also included in the
results is an estimate of the total weight of rebar in the slab and of the average weight per unit area.

Shear capacity is checked at critical locations in each span. For two-way slabs the punching shear is checked at each support. For beams and one-way slabs the required shear spacing is calculated at 1/20th points in each span.

4.5 INVESTIGATION CAPABILITIES

ADAPT-RC can also be used to analyze an existing beam or slab. The investigation mode allows the user to implement the geometry, loading and material properties already provided in the input-editing mode along with additional variable input. Fig. 1-1 outlines the investigation options implemented in ADAPT-RC. In option 1, the user inputs the slab geometry and available reinforcement, and ADAPT-RC calculates the moment capacity of the slab at 1/20th points for each span. Alternatively, in option 2 the user inputs the slab geometry, available reinforcement, and loading, and ADAPT-RC calculates the moment capacity for comparison to the moment demand at each 1/20th point. In option 3 the user inputs the geometry, available reinforcement and the moment demand on the slab, and ADAPT-RC again calculates capacities for comparison. Deflections and required reinforcement are also calculated for options 2 and 3. In all cases the results may be viewed and printed in graphical and tabulated formats.
5. OVERVIEW

This chapter describes Graphical User Interface (GUI) for the main program screen and data input module of ADAPT-PT program.

All program functions, including data entry and program execution are accessed through the Main Program window. The data entry is done through separate program module called ADAPT-PT Input.

5.1 THE MAIN PROGRAM WINDOW

Figure 5.1-1 shows the main ADAPT-RC program screen as it appears once a project has been opened.
Main Program Title Bar. Contains program name and name and location of the opened file.

Main Menu Bar. Lists all available menus in main program window. Menu options will be grayed out when they are not applicable. For example, if there is no project open, the Save As, Close and Print options on the File menu will be grayed out.

Main Toolbar. Main Toolbar contains all available tools in the main program window. The tools will not be available when they are not applicable. For example:

- If you open ADAPT-RC program available tools are:
  ![Toolbar Icons]

- If you open existing file the main toolbar contains the following options:
  ![Toolbar Icons]

Status Bar. Status bar gives you information about project name, selected design code, units, execution mode, key type, current date and time. To turn Status Bar on or off go to View -> Status Bar.

Hint Window. Hint window gives you information on how to proceed if you want to edit, execute or view your structure. To close the Hint Window, right click anywhere on the screen.

5.1.1 Main Program Window Menu Items and Corresponding Tools

All options that can be accessed by the main program menus are listed below. For the commands that might be activated using the toolbar, the appropriate icon is displayed next to the feature.

5.1.1.1 File Menu

The File Menu operations are:

New. Starts a new project. 

Open. Opens an existing project.
**Save As.** Saves both the input files and the results report file under a user-specified filename.

**Save As Default Values.** Once you save data using this option, the program will open all the new projects in the future using the values you saved. To change the default values, open a new file, modify the parameters of your choice, and re-save it using Save As Default Values.

**Close.** Closes the currently open project.

**Delete Intermediate Files.** Deletes all intermediate calculation files from the current project directory.

**Export Graph.** Allows the user to export the currently active graph as either a bitmap (.BMP) or a Windows metafile (.WMF).

**Print.** Prints the currently active report or graph window.

**Page/Print Setup.** Sets the paper size, report margins, paper orientation and printer.

**Exit.** Closes all windows and exits the program.

### 5.1.1.2 Action Menu

The Action menu operations are:

**Enter/Edit Data.** Opens the data input editor.

**Execute Analysis.** Executes the program calculations.

**Enter Investigation Data.** Opens the Investigation Data window for the Investigation Mode. The user may quickly refine a design by controlling the steel provided or the design demand.

### 5.1.1.3 View Menu

The View menu operations are:
Status Bar. Turns the status bar at the bottom of the main window on and off.

Graphs. The Graphs menu item opens a submenu, which allows any or all of the Results Graphs to be viewed. The Show Graphs button on the main toolbar displays all graphs.

RC Summary. Allows you to see result graphs for moments, forces, and reinforcement for each load combination and envelope. Also it displays the report summary sheet.

5.1.1.4 Options Menu

The Options menu operations are:

System of Units. Allows the user to select the default units (American, SI, MKS).

Design Code. Allows the user to select the default code.

ACI Minimum Bar Required. Allows the user to consider or disregard the ACI minimum bar required.

Investigation Mode. Opens the dialogue box shown below where three different investigation options may be set. (Fig. 5.2-3)

![Investigation Mode Options](image)

FIGURE 5.1-2

Verify Investigation Data. Automatically verifies input data in Investigation Data input box.

Remember Printer Selection. If this option is checked, the program uses the latest printer settings for all future runs, regardless of the default printer selected in the Windows settings.
Report Setup. Opens a Report Generator window where the report contents may be set.

Graph Properties. Opens a submenu containing a series of graphing features that may be applied to all graphs generated by the program.

Spreadsheet Options. Configures the action of the Enter key in all spreadsheet-type windows in ADAPT-RC. The key may be set to control cursor movement.

5.1.1.5 Window Menu

The Window menu operations are:

This menu controls the arrangement of open windows on the screen. This menu lists which of the graph windows are open. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.

5.1.1.6 Help Menu

The Help menu operations are:

About ADAPT. Company address and e-mail information.

About ADAPT-RC. Program information such as version.

Support Programs. Information on how to obtain program support with contact details.

Disclaimer. Defines responsibility of the software user.

Calculator. Invokes the standard windows calculation.

5.2 ADAPT-RC INPUT SCREEN

Project input data is created/edited through separate program module called ADAPT-RC Input. The input editor is used both to enter new projects and edit existing files.
• To enter a new project either click **New** on the **File** menu or click the **New** button, , on the Main Toolbar.

• To edit existing file either click on **Enter/Edit Data** on the **Actions** menu on the Main Menu bar, or click the **Edit Data** button, , on the Main Toolbar.

**Figure 5.2-1** shows the ADAPT-RC Input screen as it appears once the input editor is opened.

**FIGURE 5.2-1 ADAPT-RC INPUT SCREEN**

**RC Input Title Bar.** Contains program name, and name and location of the opened file.

**RC Input Menu Bar.** Menu bar lists all available menus in ADAPT-RC Input.

**RC Input Toolbar.** This toolbar contains all available tools in the ADAPT-RC Input.
Input Form. Each input form is the dialog box that will prompt you to select options or enter required information. When first entering data for a project, you would typically go through the screens in order by clicking on the Next and Back buttons or pressing ALT-N and ALT-B. In subsequent editing, specific screens may be selected from the PT Input menu.

If the input form contains a table (Fig. 5.2-2) the right mouse click will give you the following options:

- Insert new line
- Delete line
- Copy selected lines
- Paste lines

![FIGURE 5.2-2 SPAN GEOMETRY INPUT SCREEN](image)

Each table contains a Typical row for fast input of data. The typical input row (top row) can be used if several rows in a column have same data. To enter typical values, type the value into the appropriate cell in the top row and then press ENTER. The typical value will be copied to all rows in the column. The value of any field initialized in this manner can be subsequently changed as necessary. Data can be entered in the typical row at random; it is not necessary to enter values in all fields of the typical row.

3D Structure View. Structure View window (Fig. 5.2-3) allows you to view the structure, loads, tendons, and rebar in 3D as you enter the data. The Program displays the properties of each component at the bottom of the structure view screen if you bring the mouse pointer over it. Also you can display using right click. You can change the display in 3D window with View Tools toolbar. The toolbar function is explained in Section 5.2.1.11.
5.2.1 ADAPT RC-Input Menu Items and Tools

All options that can be accessed by the RC Input menus are listed below.

5.2.1.1 File

This menu items have the same function as File menu in the main program screen. (Section 5.1.1.1)

5.2.1.2 Project

This menu enables you to specify the project title, structural system and select analysis and design options through General Settings and Design settings input forms.

5.2.1.3 Geometry

This menu enables you to access input forms that you use to define geometry of a model. The input forms included in this menu are:

- Span geometry
- Effective Flange width
- Drop cap/transverse beam
- Drop panel
• Support geometry
• Boundary conditions

5.2.1.4 Loads

This menu opens the Loads input form where you can specify the loads.

5.2.1.5 Material

This menu enables you to access input forms where you can specify material properties for:

• Concrete
• Reinforcement

5.2.1.6 Criteria

Criteria menu contains all input screens that you use to specify project criteria. The Criteria menu input forms are:

• Base Non-Prestressed reinforcement
• Minimum covers
• Minimum bar extensions
• Load combinations
• Design code

5.2.1.7 Execute

If you click on the Execute menu the program will initiate an analysis. The corresponding tool is Execute Design, in the Common toolbar.

5.2.1.8 Tools

The Tools menu allows you to convert units and change color settings. The menu items are:

• Convert units
• Color selection
5.2.1.9 Window

This menu controls the arrangement of open graph windows on the screen. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.

5.2.1.10 Structure View

If you click on this menu it will open the 3D structure view.

5.2.1.11 View Tools Toolbar

This toolbar contains tools for selecting the entities that you want to be visible on the screen, as well as for creating rendered or shaded views of structural models. It is used to zoom in or out, pan, increase scale, create a screen shot, and print.

- **Plan View.** It will show structure in plan view.
- **Elevation View.** It will show structure in elevation view.
- **Isometric View.** It will show structure in 3D isometric view.
- **Free Rotate Perspective View.**
- **Wire Frame.**
- **Transparent Shader.**
- **Solid Shader.**
- **Outline Shader.**
- **Show/Hide Gridlines.** Displays or hides gridlines and reference line.
Show/Hide Span. Displays or hides spans of the structural model.

Show/Hide Supports. Displays or hides columns and walls of the structural model.

Show/Hide Drops/Beam. Displays or hides drop caps and beams of the structural model.

Show/Hide Loads. Displays or hides all loads that have been identified as “visible” in the Select/Set View Items window.

Show/Hide Rebar. Displays or hides the entire user defined (base) reinforcement.

Show/Hide Fixity. Displays or hides all fixity symbols of the supports.

Increase Scale Factor. This tool provides you with the option of distorting the dimension of the model in one or more direction, in order to obtain a better view of its details.

Select/Set View Items (Fig. 5.2-4). This button is used to set the display of the project items on the screen. Depending on which boxes you select, you can display additional information about each entity.

Dynamic Pan.

Rotate.

Zoom In.

Zoom Out.

Zoom Extents.
Zoom Area.

Dynamic Zoom.

Screen Capture. Takes a screen shot of the Structure View window.

Print. Prints currently active window.

FIGURE 5.2-4 3D DISPLAY SETTINGS DIALOG BOX
Chapter 6

BASIC PROGRAM OPERATIONS
6. OVERVIEW

This chapter explains the basic program operations.

6.1 START A NEW PROJECT

When starting a new project you should specify design code and system of units.

To start a new project:

1. Double-click on RC icon of your desktop to open the program.
2. Select File->New, or click on the New Project button, □.

6.2 OPEN AN EXISTING PROJECT

To open an existing project:

1. In the Main program window select File -> Open, or click on the Open Project button, 📊.
2. Select the .ADB file that you want to open.

Note: The four most recently accessed files will be recorded in File menu for easy access.

6.3 SAVE INPUT DATA

1. To save the input data and execute the analysis and design, either select Execute from the Input Editor menu or click on the Execute Design button, 📊.
   - If you are entering a new project, you will be prompted for a file name and directory in which to save the file. Once the file is saved, the program will automatically execute the analysis and design.
If you opened an existing project, it will be saved to the same directory, under the same filename. The program will then automatically execute the analysis and design.

2. To save the input data and return to the Main Program window, select either Save or Save As from the Input Editor File menu or select the Save button, on the Input Editor Toolbar.

   o If you have opened an existing file, Save will save the file under the same name, in the same directory.

   o Save As will allow you to change the file name and/or directory.

6.4 SAVE INPUT DATA AS DEFAULT

Note that it is often not necessary to go through all of the screens, even when entering a new project. Much of the information on the Materials and Criteria input screens will be the same on many projects. The program is set up with ADAPT defaults for all screens.

To change the default values from ADAPT selected:

1. Open the file with the data you would like to save as default and use in other files.

2. Choose File->Save as Default. The program will save the file as “default” ADB file. Once you saved data using this option, the program will open all the future new projects using the values in the data you saved. To change the default values, open a new file, and re-save it using Save As Default Values.

6.5 SELECT SYSTEM OF UNITS

ADAPT RC features three systems of units: SI, MKS and American (known as Imperial).

To select system of units for the new project:

1. Double-click on the RC icon on your desktop to open the main program window.
2. Select Options -> System of Units.

3. Check one of the options: SI, MKS or American. The program will automatically close the Options menu.

6.6 CONVERT SYSTEM OF UNITS

To convert system of units:

1. Open an existing project.

2. Click on **Edit Data** tool, to open **Input Editor**.

3. Select **Tools** -> **Convert Units**. The **Convert-Units** dialog box opens (**Fig. 6.6-1**).

4. Select **New Unit** and click **Convert**.

Note: The **Convert Unit** option is available only if the design code is ACI.

![Convert Units Dialog Box](image)

**FIGURE 6.6-1 CONVERT UNITS DIALOG BOX**

6.7 SELECT DESIGN CODE

To select a design code prior to edit data:

1. Double-click on the RC icon on your desktop to open the main program window.

2. Select Options -> Design Code.
Check one of the codes available. The program will automatically close the Options menu.

Note: All the codes will be available only if the system of units is SI. Otherwise only ACI codes will be available to select.
Chapter 7

STRUCTURAL MODELING AND EXECUTION
7 OVERVIEW

During the structural modeling step, the user defines the basic analysis and design parameters, i.e. the structural system (beam, one-way or two-way slab), the span lengths, cross-sectional geometries, tributary widths and supports. The user also defines the loading, material properties, reinforcement covers, minimum bar extension and load factors. This is the most critical stage of the modeling process. The user’s experience and engineering judgment play a major role in the selection of suitable design parameters. This stage of the modeling should be performed, or at least reviewed, by a senior engineer. A structure that is not modeled correctly is not likely to yield reasonable results using ADAPT-RC or any other software.

Data entry in ADAPT-RC is independent from the execution of the analysis. Data for a particular project may be entered at any time for later execution. Data is entered through ADAPT-RC Input screens described in Section 5.2.

To save the data and execute the analysis, the user has to click on the Save Data and Execute button or press the Execute command in the main toolbar. After execution of the analysis, the buttons for the investigation data input and execution automatically appear on the main menu. After choosing data for the investigation, the analysis can be restarted by clicking on the Execute Investigation button.

7.1 PROJECT INFORMATION

Project information includes specification of general information and analysis and design options.

7.1.1 Specify General Project Information

The General Settings window automatically opens when a new project is started or an existing project is opened. This screen is also available through menu option Project -> General Settings.
FIGURE 7.1-1 GENERAL SETTINGS INPUT SCREEN

Input information as follows:

1. Type in General and Specific title. Note that the General title and Specific title of the project will appear at the cover page of a report and in the header of each page of a report.

2. Select Geometry input option.
   - If you model spans with uniform geometry where the tributary width, section type and/or section depth do not change within a span, select Conventional input. This will also give you an option to include drop caps, drop panels, and/or transverse beams.
   - If you model spans with non-uniform geometry within a span, select Segmental input.

3. Select a type of a Structural System.
   - If you select Two-Way slab you will have an option to include drop caps, drop panels and/or transverse beams.
   - If you select One-Way Slab you will have an option to include transverse beams only.
   - If you select Beam you will have an option to include an effective flange width in the calculations.
4. Click **Next**. This will save input data and open next input screen **Criteria – Design Code** where you can select design code.

### 7.1.2 Specify Analysis and Design Options

You can select various analysis and design options through the **Design Settings** dialog box (Fig. 7.1-2).

To specify analysis and design options:

1. Click on **Project->Design Settings**. The **Design Settings** input screen opens.

![Design Settings Input Screen](image)

#### FIGURE 7.1-2 DESIGN SETTINGS INPUT SCREEN

2. Select Analysis options

   - If you select “Yes” for **Reduce Moments to face-of-support**, the calculated moment at the support centerline will be adjusted to face-of-support and used in design.
   
   - If you select “Yes” for **Redistribute moments (post-elastic)**, the program will perform redistribution of moments and readjust elastic moments based on the provisions of the selected design code.
   
   - If you select “Yes” for **Use Equivalent Frame Method**, the program models the structure using the Equivalent Frame Method (EFM). This option is available only for two-way systems.
If you select “Yes” for **Increase Moment of Inertia Over Support**, the program will internally model the structure with increased moment of inertia over supports. This option affects the relative stiffness of the beam and column members. The option is available for one-way systems and two-way systems where the Equivalent Frame Method is not used.

3. **Select Design options**

   - If you select **Use all provisions of the code** the program will consider all provisions of the selected design code including calculation of minimum rebar for serviceability, check for cracking capacity and add reinforcement if needed.

   - If you select **Disregard the following provisions** you will have an option to choose which of the following provisions you would like to disregard in design:
     - If you choose to disregard **Minimum rebar for serviceability** the program will not report minimum rebar.
     - If you choose to disregard **Design capacity exceeding cracking moment** the program will not report the rebar due to design capacity exceeding cracking moment capacity.

4. Specify the percentage of top and bottom reinforcement that will participate in resisting unbalanced moment. This option is available only for two-way systems.

5. Click **Next**. This will save input data and open a new input screen Span geometry where you can specify geometry of spans.

### 7.2 GEOMETRY

The geometry of the problem is defined via a series of input screens that can be accessed through the Geometry menu. The screens will vary depending on which structural system has been specified. There are three basic screens: Span Geometry, Support-Geometry, and Support-Boundary conditions. Additional
screens are used to enter effective flange widths, segmental data, drop caps, drop panels and transverse beams.

### 7.2.1 Specify Span Geometry

The span geometry can be modeled as prismatic (uniform) or non-prismatic (non-uniform).

- The geometry without changes in cross-section along the span excluding geometry of drop cap, drop panels or transverse beams is called prismatic (uniform) geometry.
- Geometry of a cross-section that changes along the span is called non-prismatic (non-uniform) geometry. You will have to model span geometry as non-uniform if at least one span is not uniform.

### 7.2.1.1 Prismatic (Uniform) Spans

The **Span Geometry** screen is used to enter the cross-sectional geometry of the slab or beam at midspan (Fig. 7.2-1).

To input data for uniform spans do the following:

1. Open **Span Geometry**.

2. To set the number of spans, use **CTRL+/-** or click on the up/down arrow at the left of the screen. If there are cantilevers on the right and/or left ends of the frame, add them by clicking on the appropriate check box. This will activate the input fields for the corresponding cantilever.

3. Select section type by clicking on the button in the **Sec.** column. Section type can be set to Rectangular, T section, I or L section, and Extended T section.

4. Enter the dimensions of the span sections. All dimensions are defined in the legend at the top of the screen and/or illustrated in the appropriate section figure.

- Span lengths are measured from support centerline to support centerline.
The tributary width (dimension b) is composed of left tributary (the portion of the tributary width that falls to the left of the frame line) and the right tributary (the portion that falls to the right of the frame line). The tributary width can vary from span to span but is assumed to be constant within a single span unless segmental input is used.

There are two methods of modeling tributary width: Unit Strip input and Tributary input. Both methods produce the same results, which method to use is a matter of user preference. Once a method is selected however, it should be used consistently throughout a given project to avoid confusion. Note that the calculations and results are always shown in terms of the total tributary width, regardless of the way the slab was modeled during data entry. Refer to Chapter 4 for a full explanation of Unit Strip and Tributary Modeling. In the present example, the unit strip option is used.

5. Enter reference height (Rh). The reference height identifies the position of a reference line that is used to model steps at the top of the slab. The Rh indicates the distance from the reference line to the top of the slab with positive being measured upwards. Typically, the reference line is set at the top of the slab.

The Typical input row (top row) is used if several spans have similar dimensions. For example, if the width of a unit strip is 12 in. (or 1000 mm), enter 12 (or 1000) under the respective column.
on typical row and press enter, the widths for all spans will be assigned an initial value of 12 (or 1000). Naturally, the user may then further edit any of the prescribed fields and change the initialized values if required. It is not necessary to use all the fields of the typical row. This typical row can be accessed at random.

7.2.1.2 Non-prismatic (non-uniform) spans

The following example illustrates data entry for a non-prismatic section using the segmental option. The example is a single span beam, which is made up of seven segments of varying cross-sectional geometries (Fig. 7.2-3). The details of the beam’s cross-section are shown in Fig. 7.2-4.

FIGURE 7.2-3

Although this is not a practical design, it illustrates ADAPT’s ability to model complex geometries.
FIGURE 7.2-4

To model non prismatic span do the following:

1. Select Segmental in the General Settings input form.

2. Open Span Geometry (Fig. 7.2-4). The general span data on this screen is entered as if the beam were prismatic, except that the prismatic column input is changed to “nonprismatic” for each span where segmental input is to be utilized.

3. To set the number of spans, use CTRL+/-. or click on the up/down arrow at the left of the screen. If there are cantilevers on the right and/or left ends of the frame, add them by clicking on the appropriate check box. This will activate the input fields for the corresponding cantilever.

4. Select section type by clicking on the button in the Sec. column.

5. Enter the dimensions of the span sections. All dimensions are defined in the legend at the top of the screen and/or illustrated in the appropriate section figure. The dimensions specified in the Span Geometry screen including reference height and left and right multipliers define the geometry of a mid segment of the span. All other segments of the span are defined in the Geometry-Span (More) screen as explained in the following.
6. Change prismatic column PR to NP. Changing a span to NP activates the More button in the Seg. column.

7. Click on the More button in the Seg. column to open the Geometry-Span (More) window for that span (Fig. 7.2-5).

8. To set the number of segments in the spans, use CTRL+/-. or click on the up/down arrow at the left of the screen. Up to seven segments may be entered per span. The parameters are input in the same manner as general span geometry data except the XL column is used to specify the distance from the left support centerline to the start of the segment. The length of each segment is calculated automatically based on the distance to the start of the next segment. The start of the first segment is always zero.

Note that if either the Use Equivalent Frame Method or Increase Moment of Inertia Over Support option was selected, the program will automatically generate additional segments over each support using the geometry entered for the first and last segments. If the first and last segments are generated before the support dimensions are entered, their XL values will be initialized with values of zero and the
span length, respectively. These values will be updated when the support dimensions are entered.

9. Click OK to save input data and close Geometry-Span (More) window.

10. When you complete data input for all spans click Next to save the data and to open next input screen Support Geometry and Stiffness.

7.2.2 Specify Effective Flange Width

If you enter a beam and you answer ‘Yes’ to Consider Effective Flange Width on the General Settings screen, the Span Geometry screen will be followed by the Effective Flange Width screen (Fig. 7.2-6). This screen is also available through menu Geometry -> Effective Flange Width.

![Effective Flange Width Input Screen](image)

**FIGURE 7.2-6 EFFECTIVE FLANGE WIDTH INPUT SCREEN**

1. Open Effective Flange Width input screen.

2. Select Effective width calculation method.
   - If you choose to use the ACI-318 method of effective flange width calculation, the resulting flange widths based on ACI-318 code will be displayed, but you will not be able to edit them.
If you select **User Input** calculation, the effective \( b_e \) column will default to the ACI calculated values, but you will be able to change them.

3. Click **Next** to save data and go to the next input form.

Note: ACI does not actually specify an effective flange width for prestressed beams. The widths calculated by the program are in accordance with the ACI recommendations for non-prestressed beams.

### 7.2.3 Specify Geometry of Drop Cap and/or Transverse Beam

If you enter a two-way system and you answered “Yes” to the **Include Drops & Transverse Beams** question on the **General Settings** screen, the **Span Geometry** screen will be followed by the **Geometry-Drop Cap/Transverse Beam** screen (Fig. 7.2-7). This screen is also available through menu **Geometry -> Drop Cap/Transverse Beam**.

The input parameters are defined in the figures at the top of the screen. Note that \( H \), the depth of the cap or beam, is the total depth of the section, not the depth below the slab.

![Geometry Drop Cap / Transverse Beam](Fig. 7.2-7)

If there are drop caps or transverse beams with the same dimensions at several supports, their dimensions may be entered using the typical row. To enter typical values for drop caps, type the value into the typical row and press ENTER. The value will be copied to any supports that have been
marked as having drop caps. Any supports which are subsequently marked as having drop caps will also be assigned this value as a default.

Transverse Beams dimensions are entered in the same manner.

### 7.2.4 Specify Geometry of a Drop Panel

If you enter a two-way system and you answered “Yes” to the Include Drops & Transverse Beams question on the General Settings screen, the Drop Cap/Transverse Beam screen will be followed by the Geometry-Drop Panel screen (Fig. 7.2-8). This screen is also available through menu Geometry -> Drop Panel.

![Geometry - Drop Panel](image)

#### FIGURE 7.2-8 DROP PANEL INPUT SCREEN

The data entries for drop panels are the same as for drop caps. Typical values can be entered with the typical row at the top of the table.

### 7.2.5 Specify Support Geometry and Stiffness

This screen is used to input support geometry and location in the model at the top and/or bottom of the slab (Fig. 7.2-9). The input parameters are clearly illustrated in the screen’s legend and section figures. Support selection options will change depending on the structural system you selected.
FIGURE 7.2-9 SUPPORT GEOMETRY AND STIFFNESS INPUT FORM

If you model a two-way system or a beam, the available support options will be:

- Lower column,
- Both columns,
- No columns

If you model a one-way system the support options will be:

- Lower wall,
- Both walls,
- Point support or transverse beam

To model supports do the following:

1. Select lower, both or no support option.

2. Enter the height of lower supports (H1) if any. H1 is the distance from the mid-depth of the slab to the top of the slab below.

3. Specify cross section dimension for support:
   - If rectangular, enter data in column D (dimension in span direction) and B (dimension perpendicular to span direction).
If circular, enter data in column $D_c$ (diameter of circular column).

4. Specify the percentage column stiffness that you would like to consider in analysis.

5. Repeat the procedure to define geometry of upper columns if any, or simply copy the data.

6. If you model a two-way system you will have an option to assign a **Left edge** and **Right edge** condition. This option is available only for two-way systems and it is used to determine the column condition for punching shear check.

   - If you select **Exterior** the program will automatically check the left and right tributary width in addition to the left and right distance to the slab edge in the span direction. If the tributary that falls to the left or to the right side of the column is less than code required for interior column, the program will automatically consider it as an exterior column.

   - If you select **Interior** the program doesn’t check left and right tributary width, only checks the span direction distance to slab edge and treats the column as interior/end.

Note: The program always checks left and right distance to the slab edge. If the dimension $B$ of a column is at least 80% of tributary width the program will treat this column as wall and will not check it for punching shear.

### 7.2.6 Specify Support Boundary Conditions

This screen is used to enter support widths and column boundary conditions (Fig. 7.2-10).
1. Select **Slab/beam boundary conditions at far ends**.
   - Choose “No” if the slab end is rotationally free. This occurs when a slab/beam terminates over wall, column or beam.
   - Choose “Yes” if the slab end is rotationally fixed. This occurs if the span/beam end is tied to a structure that is rigid enough to prevent rotation. A typical example might be slab tied to a stiff shear wall. A rotationally fixed end condition can also be used to model half of a symmetrical, multi-span frame if there will be no rotation over the support at the line of symmetry.

   Note: If there is a cantilever at the right or left end of span, the corresponding slab/beam end condition option will not be available.

2. Specify support width **SW**. This option is available if you choose “Yes” to the **Reduce Moments to face-of – support** option in the **Design Settings** screen.
   - To automatically set the values in **SW** column to actual support widths, **D**, check box in front **SW = Actual width of support**. This option will not be available if you select no columns or point support /transverse beam option for supports.
3. Choose support boundary conditions by clicking on the arrow in the appropriate cell of the table. The following figure shows the available boundary conditions and symbols used in 3D view.

![Boundary Conditions](image)

**FIGURE 7.2-11 BOUNDARY CONDITIONS**

Note: If **No Columns** option was specified on the **Supports-Geometry** screen the boundary condition entries will be ignored. The support widths will be used to calculate reduced moments, however.

### 7.3 LOADS

ADAPT RC allows you to specify a variety of load types including dead, live, earthquake or wind loads (lateral loads).

#### 7.3.1 Specify Dead, Live and Other loads

Figure 7.3-1 shows the screen used to enter loading information.
FIGURE 7.3-1 LOAD INPUT FORM

1. Specify loaded spans.

   o To enter load for an individual span, click on the arrow in cell of the **Span** column and select a span number from the list of all available spans, or just type in a span number.

   o To enter a load for all spans, enter ‘all’ or ‘ALL’ as the span number.

   o To enter loads on a left cantilever, enter either LC or 0 as the span number. To enter loads on a right cantilever, enter either RC or the number of spans +1 as the span number.

2. Specify the class of load by clicking on the arrow in the cell of a **Class** column. There are four available classes:

   o **SW** – selfweight. This load class will be available only if you select “No” for Include selfweight option. In this case you have an option to enter selfweight of the structure manually instead of allowing the program to calculate it.

   o **SDL** – superimposed dead load

   o **LL** – live load

   o **X** – other load

4. Specify the type of loading by typing **U**, **P**, **C**, **M**, **L**, **R**, **V**, or **Z** in the **L/T-?** column, or by dragging the icon from the graphics of the loading that you intend to apply to the cell in the **L/T-?** column. There are eight load types:
Note: Uniform and partial loads are assumed to be uniformly distributed over the upper most surface of the member with a constant intensity per unit area. The user only needs to enter the loads intensity, and ADAPT calculates the frame loadings. These frame loadings are reported in report table 3.2 Compiled loading.

4. Enter load intensity and position. The schematics for each load type indicate the required input data. Note that on cantilevers, distances are always measured from the support (Fig. 3.3.10-2). The distances for a left cantilever are thus entered contrary to those of the typical spans.

![Diagram of cantilevers](image)

**FIGURE 7.3-2**

Any number of different loads and load types may be entered for a span. You may also specify whether to skip the live loading and whether to calculate self-weight automatically. If these features are selected, the skip factor and concrete unit weight must be entered.

### 7.3.2 Specify Lateral Loads

ADAPT-RC allows you to specify lateral loads (wind or earthquake loads) as unbalanced concentrated moments acting at the face of supports. To define these loads:
1. Go to Criteria -> Load Combination.

2. Check Include Lateral Loads and click Set Values.

3. Go to Lateral moments tab and input values. (Fig. 7.3-3)

4. Click OK. The lateral moments will show on the screen.

7.4 MATERIAL

7.4.1 Specify Concrete Material

This screen is used to enter concrete properties (Fig. 7.4-1).
Depending on the code, the concrete weight classification is used in shear and/or flexure calculations. Default values of the modulus of elasticity are calculated based on the concrete strength and the appropriate code formula. The ultimate creep coefficient is used in the calculation of long-term deflections.

### 7.4.2 Specify Reinforcement Material

This screen is used to specify bar sizes and properties for longitudinal and shear reinforcement (Fig. 7.4-2).

**FIGURE 7.4-2 STEEL MATERIAL INPUT SCREEN**

When entering data for a beam and one-way slab, there will be an entry for preferred stirrup bar size and number of legs. When entering data for two-way slab there will be an option to select between stirrups and studs.

- If you select **Studs** the program will ask you to specify stud diameter and number of rails per side of a column.

- If you select **Stirrups** the program will ask you to specify stirrup bar size.

The preferred bar sizes are used when calculating the number of bars required. The bar sizes may be changed on the RC Summary report, however.

The allocation of reinforcement to column strip in two-way floor system is entered directly. The remaining will be distributed for the middle strip.
7.5 CRITERIA

7.5.1 Specify Base Non-Prestressed Reinforcement

This screen is used to specify base non-prestressed reinforcement (Fig. 7.5-1).

![Base Non-Prestressed Reinforcement Input Screen]

The program allows you to specify a base reinforcement that is taken into consideration when designing the structure. You have an option to define reinforcement as mesh or isolated bars. The position of a bar is defined with distances of the first X1 and second X2 bar end to its immediate left support.

For example Bar 3 starts at 0.8 of Span 2 and ends at 0.2 of Span 3.

![Base Non-Prestressed Reinforcement Diagram]

The user can see the base reinforcement in the 3D Structure View window as shown in Figure 7.5-2.
7.5.2 Specify Minimum Covers

This screen is used to specify the clear bar covers for the nonprestressed reinforcement (Fig. 7.5-4).

![Criteria: Cover / CGS](image)

**FIGURE 7.5-4 CRITERIA –COVER INPUT SCREEN**

7.5.3 Specify Minimum Bar Extension

This screen is used to specify the top bar and bottom bar extension. Bar lengths for ultimate strength are based upon the location of moment inflection points. The extension lengths are added to the bar lengths to extend the bars beyond the inflection points (Fig. 7.5-5).
7.5.4 Specify Load Combinations

This screen is used to define the load combination factors for strength (ultimate) condition. It also gives an access to the input screens for lateral loads and lateral loads combinations. (Fig. 7.5-6). It is also used to enter any applicable material factors or strength-reduction factors. The default values depend on selected design code.

To define load combinations that include lateral loads check Include lateral load option and click Set Values. The Lateral Input Data window opens (Fig. 7.5-7).
7.5.5 Specify the Design Code


To select the code:

1. Click Criteria -> Design Code. The Criteria-Design Code dialog box will open (Fig. 7.5-8)
2. Select the design code from the list.

3. Click **Next**. This will save input data and open a new input screen **Design Settings** where you can select your analysis and design options.

Note: Depending on the code chosen, materials factors and other design parameters may need to be entered. These are entered on the Load Combinations screen (**Fig. 7.5-6**). If you model in American or MKS units only ACI318 codes are available.

### 7.6 EXECUTION

The program can be executed either by selecting the **Execute Analysis** item on the **Action menu** or clicking the **Execute Analysis** button, on the **Main Toolbar**.

After the calculation has been started, there is no possibility to change the input data. Complete execution of the calculation process has to be achieved.

The execution starts by reading the data files and performing a number of preliminary checks as to the consistency of input values. If an error is detected, the program will stop and display a message box indicating the most likely source of the error. The data consistency checks incorporated in ADAPT-RC are not exhaustive, however, which means that the user is ultimately responsible for ensuring that the data is entered correctly.

### 7.7 INVESTIGATION DATA AND EXECUTION

ADAPT-RC includes an additional feature that provides the user with additional information beyond the usual scope of design. This is accessed by pressing the **Investigation Data** button on the main screen. This will be available only after the execution of the program.

**Figure 7.7-1** shows the investigation data dialogue box. The box consists of two tables: an input data table for the reinforcement and an input data table for the design moments.
Investigation can be facilitated by clicking the **Investigate Execution** button on the main toolbar or using the **Execute Investigation** option in the **Action** menu. The files that are created directly from the Investigation Calculation are as follows:

- **RCAMCAP.USR**
- **RCAREB.USR**
Chapter 8

VIEW/VALIDATE RESULTS
8 OVERVIEW

After the analysis is executed a graphical report can be generated. The RC summary module, ADAPT-RC Sum, enables you to generate comprehensive graphical reports for each ADAPT-RC run. You have an option to display and print results graphs for each load combination and generate a report that summarizes all post-tensioning parameters, rebar requirements and shear checks on a single page of output.

8.1 ADAPT-RC SUM SCREEN

To invoke ADAPT-RC Sum, click on the Open RCSum button, or select the RC Sumary menu item from the View menu in the Main program window. The window will open as shown in Figure 8.1-1.

FIGURE 8.1-1
RC Sum Title Bar. Contains program name, and name and location of the opened file.

RC Sum Menu bar. Menu bar lists all available menus in ADAPT-RC Sum module.

RC Sum Toolbar. This toolbar contains all available tools in the ADAPT-RC Sum screen.

Status Bar. Status bar gives you information about units, current date and time.

Combination List. This is a drop down list that contains all available load combinations.

8.1.1 ADAPT-RC Sum Menu Items and Corresponding Tools

All options that can be accessed by the RC Sum program menus are listed below. For the commands that might be activated using the toolbar, the appropriate icon is displayed next to the feature.

8.1.1.1 File menu

Export Graph. Allows you to export the currently active result graph or summary report as either a bitmap (.BMP) file or a Windows metafile (.WMF). The graph or report must first be set up with the desired information and in the desired format.

Print. This tool prints active result graph with frame containing project information or active Summary Report.

When you print a graph the program will display the Print screen (Fig. 8.1-2) where you have an option to select sheet orientation and add additional comments that will appear at the bottom of the graph (Fig. 8.1-3).
8.1.1.2 Graphs menu

**Summary.** When you select this option the Summary Report window of the selected load combination will open with a default format for the Summary report as shown in **Fig. 8.1-8**.

**View All Graphs.** This option will show all available graphs for selected load combination or envelope.

**Forces Diagram.** This tool displays forces diagram for selected load combination or envelope (**Fig. 8.1-4**).
Moment Diagram. This tool displays bending moment diagram for selected load combination or envelope (Fig. 8.1-5).

Rebar Diagram. Displays calculated rebar for the selected load combination or envelope. The graph shows required rebar calculated at 1/20th points and provided rebar (Fig. 8.1-7).
8.1.1.3 Options menu

**Summary options.** Displays summary report setup window (Fig. 8.1-9 (a)-(c)). It has the same function as Report Setup button, on the Span Selection toolbar. (Note: Span selection toolbar will be available only for the summary report)

**Graph properties.** Configures the graphs generated by the program. Options include whether to include X and Y gridlines, min/max data points and a legend. Also include Bitmap size and Graph fonts setup screens.

8.1.1.4 Window menu

This menu lists which of the graph windows are open. The graphs may be stacked vertically for scrolling, or the windows may be cascaded.

8.1.1.5 Help menu

**Contents.** Shows the help contents of ADAPT-RC.

8.1.1.6 Summary Report

The Figure 8.1-8 shows Summary report as it opens once you select Summary from Graphs menu, or click on Summary report button, in the main toolbar.
The format of Summary report can be modified using the Span Selection Toolbar. With this toolbar you can select which of the data blocks to print, or you can recalculate the mild steel requirements using a bar size which is different from what was initially specified in the ADAPT run. In addition, you can select to print the report in color or black-and-white, portrait or landscape, and on a variety of paper sizes. After the data blocks are selected, the report is automatically rescaled to fit the specified paper size.

The following is the description of the Span Selection Toolbar.

Span Selection Toolbar

**Report Setup.** To specify what information to print, select the Report Setup. A window with three tabs will appear. **Figure 8.1-9 (a-c)** shows these three tabs:
• Use the check boxes on the ‘Sections to be printed’ tab to select which data blocks to print.

**FIGURE 8.1-9A**

• Use the ‘Rebar Selection’ tab to change the bar sizes or bar system used for top and bottom reinforcing steel.

**FIGURE 8.1-9b**

The bar system used for the ADAPT-RC analysis is determined according to the design code selected during data input. The preferred bar size is also specified during data input. Although these will be used as defaults for the Summary Report, both the bar system and bar size can be changed.

All of the bars systems shown on the Rebar Selection tab (ASTM - US Customary, ASTM - US SI, Euro or CSA) are available, no matter what design code was
used for the ADAPT-RC run. First, select the desired bar system. Then, specify the top and bottom bar size from the pull-down list of bar sizes available for that bar system. Click on Apply to recalculate the mild steel reinforcing requirements with the new bar sizes.

To go back to the bar system and sizes in the original ADAPT-RC run, select the ‘Use Input Data as Default’ option. Click on Apply to recalculate the number of bars required.

- Use the ‘Designer’s Notes’ tab to input notes that will be printed at the bottom of the report.

![Designer’s Notes tab](image)

**FIGURE 8.1-9C**

Click on the Apply button to apply the selected options to the report.

- **Page Setup.** This tool gives you an option to print your report in portrait or landscape.

- **Color Settings.** This tool gives you an option to print your report in color or black-and-white. This will change the color setup on both the screen and the printout.

- **Zoom options.** The Zoom buttons can be used to adjust the size of the report on the screen.

- **Spans selection.** Allows you to format the report to include only certain spans. From the left drop down list select first span and
from the right drop down list specify last span that you want to include in the Summary Report.

The following is a description of the data blocks that can be included in the Summary Report:

**Data Block 1 - General Project Information**

<table>
<thead>
<tr>
<th>ADAPT - STRUCTURAL CONCRETE SOFTWARE SYSTEM</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADAPT-RC Version: &quot;2009&quot; Date: &quot;11 - 17 - 2006&quot; Time: &quot;15.12&quot; File: Mid5-2</td>
</tr>
<tr>
<td>1 - PROJECT TITLE: &quot;THREE SPAN TWO-WAY SLAB&quot;</td>
</tr>
<tr>
<td>1.1 Design Strip: THREE SPAN TWO-WAY</td>
</tr>
<tr>
<td>1.2 Load Case: STRENGTH_1_Max_LL +1.20 SW +1.60 LL_Max+1.20 SDL +1.60 XL +0.00 LAT</td>
</tr>
</tbody>
</table>

Data block 1 contains the General and Specific titles entered during data input.

**Data Block 2 – Member Elevation**

<table>
<thead>
<tr>
<th>2 - MEMBER ELEVATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>19.17</td>
</tr>
</tbody>
</table>

Data block 2 contains an elevation view of the member with span dimensions. An elevation view of the member, including all drops and steps, with span lengths.

**Data Block 3 – Top Rebar**

<table>
<thead>
<tr>
<th>3 - TOP REBAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1 ADAPT T selected</td>
</tr>
<tr>
<td>3.2 ADAPT T selected</td>
</tr>
</tbody>
</table>

Data block 3 reports the amount and length of rebar required at the top of the member. The rebar shown is the steel required to withstand the negative moment demand.

If the steel required is controlled by the negative-moment demand, the bar lengths are based on the required rebar quantities at 1/20th points. The selected rebar is calculated as two lengths in an effort to minimize material requirements. This is particularly helpful for cases where rebar requirements vary and a large amount of reinforcing are required over a
short section of the span. In these cases, using bars that are all the same length might be an unnecessary waste of materials.

Note that the steel selected by the program is only one of several acceptable design solutions. Space has been provided in this data block for the designer to provide alternate information on rebar quantity, size and length. The designer may also use this space to write in any additional notes or remarks pertaining to the rebar.

Data Block 5 – Bottom Rebar

<table>
<thead>
<tr>
<th>5 - BOTTOM REBAR</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.1 ADAPT selected</td>
</tr>
<tr>
<td>5.2 ADAPT selected</td>
</tr>
</tbody>
</table>

Data block 5 reports the amount and length of rebar required at the bottom of the member. The format is the same as data block 3 – Top Rebar.

Data Block 6 – Required & Provided Bars

<table>
<thead>
<tr>
<th>6 - REQUIRED &amp; PROVIDED BARS</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.1 Top Bars</td>
</tr>
<tr>
<td>6.2 Bottom Bars</td>
</tr>
</tbody>
</table>

Data block 6 plots the rebar required and provided for the top and bottom of the section at each 1/20th point. The maximum required areas of steel required for the top and bottom of each span are also shown.

Data Block 7 – Shear Stirrups / Punching Shear (One-Way Shear)
For beams, data block 7 reports the stirrup size and spacing based on user input during data entry. The data block also includes a bar graph of the area of shear reinforcement required along each span.

Note: the shear diagram is only available for the envelope load combination.

**Data Block 7 – Shear Stirrups / Punching Shear (Two-way Shear)**

<table>
<thead>
<tr>
<th>7.1 Stress Ratio</th>
<th>1.55</th>
<th>1.62</th>
<th>---</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.2 Status</td>
<td>NA</td>
<td>RE</td>
<td>RE</td>
</tr>
</tbody>
</table>

For two-way slabs, data block 7 plots an elevation view of the model, which indicates the punching shear stress ratio at each support and states whether the stress ratio is acceptable per the specified code. Note: This block is available only if you select Envelope from the drop down list of load combinations on the Main toolbar.

**Data Block 9 – Design Parameters**

9.1 Code: ACI 318-19  
- $f_c = 4000$ psi  
- $f_y = 50$ ksi (longitudinal)  
- $f_y = 60$ ksi (shear)

9.2 Rebar Cover: Top = 1 in  
- Bottom = 1 in  
- Rebar Table:

Data block 9 reports the following design parameters used in the ADAPT-PT run:

- Design Code
- Concrete strength, $f_c$
- Mild steel yield strength, $f_y$ for longitudinal and shear reinforcement
- Minimum Top and Bottom rebar cover
- Rebar Table

**Data Block 10 – Designer’s Notes**

Data block 10 contains notes added by the designer. The entry in this box will be used on future runs and future projects until it is cleared. To clear
the notes entered, select Clear and then click on Apply in the ‘Designer’s Notes’ tab of Report Setup.

The Summary Report can be viewed in final form on the screen. It can then be printed or saved as either a .WMF or .BMP or copied and pasted to a word processor. If it is saved as a file, it can be inserted into contract documents, calculation packages or structural drawings.
Chapter 9

REPORTS
9 OVERVIEW

This section describes in detail the reports generated by the ADAPT-RC program for one-way slabs, two-way slabs, and beams. It is primarily intended for those who are using the report in their designs, or those who review structural designs based on the ADAPT Reinforced Concrete Software System.

The material presented identifies the input parameters by the user, the parameters which the user may edit during the execution of the program, and finally those which are computed by ADAPT. The reports clearly identify the values input by the user from those calculated by the program.

Each report is broken down into sections. Each section is given a unique identification number. The report consists of those sections that are selected by the user. Hence, the content and details of a report is user controlled. However, the user can save selected report content as templates.

9.1 REPORT GENERATOR SCREEN

To create a report click on the Report Setup button, on the Main toolbar. The Report Generator window opens (Fig. 9.1-1).

![FIGURE 9.1-1 REPORT GENERATOR SCREEN](image)

The following is the description of report generator:

**List of All Sections.** It includes a tree that lists the sections available in the report. To select a section, checkmark the box in front the section. To exclude the section uncheck the box. Note that the section will not be shown in the report tree if not
applicable. For example, if your structural system is a beam, the punching shear report will not be available.

**List of Selected Sections.** It lists all sections that you check marked to be included in your report.

- **Remove Selection** Removes highlighted selection from the drop down list.

- **Save Selection** Adds your settings to the drop down list.

- **Save as Default** Saves the current selections as default.

- **Create New Report** Generates report and displays them in rich text format (.RTF) when completed.

- **Browse Reports** Opens already created reports.

- **Update Company Info** Allows you to customize report footer and cover page.

- **Exit** Exits Report Generator and goes back to the ADAPT Main program window.

### 9.2 HOW TO CREATE REPORT

To create reports, go through the following steps:

1. First set the report to show your company information when you create the report documents. To do so click on **Update Company Info** button. The **Company Information** dialog box opens.
FIGURE 9.2-1

In the **Company Information** edit box, specify the text that you would like to include in the footer of each page of your report. To upload the company’s logo, click on the **Browse** button and upload Bitmap or JPEG file of your logo. The logo will show on the report cover page. Once you set up your company information the program will use it whenever you create new reports. If left blank, the program will use default ADAPT information.

2. Click **OK** to close **Company Information** edit box.

3. In the **Report Generator** tree, select the sections that you would like to include in your report. The selection will appear at the right side of the window in the List of Selected Sections.

4. Click on **Create New Report** button. The program will ask you to specify name and location where you would like to save your report. The default location is the .ADB file folder where your project is saved.

5. Click **OK**. The program will start generating the report. Once completed, the program will open the report in rich text format. The report content will include sections you selected and they will be shown in default program settings. You will be able to modify it as you wish.

### 9.3 DESCRIPTION OF REPORT SECTIONS

The main report sections available are:

- Report cover page
- Table of contents
- Concise report
- Tabular report-compact
- Tabular report-detailed
- Graphical reports
- Legend

The following explains each of these sections:

### 9.3.1 Report Cover Page

The program-generated cover page will contain a company logo, title, bitmap of a 3D structure view, and date (Fig. 9.3-1). The cover page will be created only if you select the Report Cover option from the list of sections.

Your company logo will appear at the top of the report cover page and will show the bitmap or JPEG file that you uploaded (Fig 9.2-1). The default cover page title will be the Generic title and Specific title of your project that you specified in the General Settings window of RC Input. While in RC Input you can set the structure view as you want it to appear on the cover page of your report. When you exit RC Input (click on Close button, or click Execute), the program will take a screen shot of the 3D structure and show it on the cover page. At the bottom of the cover page the program shows the date when you created report.
9.3.2 Table of Contents

To include a table of contents with your report, select the Table of Contents section in the Report Generator tree. The table will contain only sections that were selected by user and listed in the Selected Sections of the Report Generator window. The following table includes all sections available in ADAPT-RC report.

TABLE OF CONTENT:

Concise Report

A. - Project Design Parameters and Load Combinations
   A.1 - Project Design Parameters
   A.2 - Load Combinations

B. - Design Strip Report
   B.1 - Geometry
   B.2 - Applied Loads
   B.3 - Design Moments
       Envelope
   B.6 - Rebar Report
   B.7 - Punching Shear
   B.8 - Deflection
   B.9 - Quantities
Tabular Reports - Compact

1 - User Specified General Analysis and Design Parameters

2 - Input Geometry
   2.1 Principal Span Data of Uniform Spans
   2.2 Detailed Data for Nonuniform Spans
   2.3 Effective Width Data of Uniform Spans
   2.4 Effective Width Data for Non-Uniform Spans
   2.5 Drop Cap and Drop Panel Data
   2.6 Transverse Beam Data
   2.7 Support Width and Column Data

3 - Input Applied Loading
   3.1 - Loading As Appears in User's Input Screen
   3.2 - Compiled Loads

4 - Calculated Section Properties
   4.1 Section Properties of Uniform Spans and Cantilevers
   4.2 Section Properties for Non-Uniform Spans

5 - Moments, Shears and Reactions
   5.1 Span Moments and Shears (Excluding Live Load)
   5.2 Reactions and Column Moments (Excluding Live Load)
   5.3 Span Moments and Shears (Live Load)
   5.4 Reactions and Column Moments (Live Load)

6 - Moments Reduced to Face of Support
   6.1 Reduced Moments at Face of Support (Excluding Live Load)
   6.2 Reduced Moments at Face of Support (Live Load)

8 - Factored Moments and Reactions Envelope
   8.1 Factored Design Moments (Not Redistributed)
   8.2 Reactions and Column Moments
   8.4 Factored Design Moments (Redistributed)

9 - Factored Lateral Moments Envelope
   9.1 Input Lateral Moments
   9.2 Factored Lateral Moments (Not Redistributed)
   9.3 Factored Lateral Moments (Redistributed)

10 - Mild Steel (No Redistribution)
   10.1 - Required Rebar
      10.1.1 - Total Strip Required Rebar
      10.1.2 - Column Strip Required Rebar
      10.1.3 - Middle Strip Required Rebar
   10.2 - Provided Rebar
      10.2.1 - Total Strip Provided Rebar
      10.2.2 - Total Strip Steel Disposition
      10.2.3 - Column Strip Provided Rebar
      10.2.4 - Column Strip Steel Disposition
      10.2.5 - Middle Strip Provided Rebar
      10.2.6 - Middle Strip Steel Disposition
10.3 - Base Reinforcement
   10.3.1 - Isolated bars
   10.3.2 - Mesh Reinforcement

11 - Mild Steel (Distributed)
   11.1 - Required Rebar
      11.1.1 - Total Strip Required Rebar
      11.1.2 - Column Strip Required Rebar
      11.1.3 - Middle Strip Required Rebar
   11.2 - Provided Rebar
      11.2.1 - Total Strip Provided Rebar
      11.2.2 - Total Strip Steel Disposition
      11.2.3 - Column Strip Provided Rebar
      11.2.4 - Column Strip Steel Disposition
      11.2.5 - Middle Strip Provided Rebar
      11.2.6 - Middle Strip Steel Disposition

12 - Shear Reinforcement
   12.1 Shear Calculation Envelope

13 - Punching Shear Reinforcement
   13.1 Critical Section Geometry
   13.2 Critical Section Stresses
   13.3 Punching Shear Reinforcement

14 - Deflections
   14.1 - Maximum Span Deflections

16 - Unbalanced Moment Reinforcement
   16.1 - No Redistribution
   16.21 - Redistributed

**Tabular Reports - Detailed**

23 - Detailed Moments

24 - Detailed Shears

25 - Factored Moments and Reactions

26 - Factored Lateral Moments

29 - Detailed Rebar

30 – Punching Shear Reinforcement

32 – Unbalanced Moment Reinforcement

**Graphical Reports**

Deflection

Load Cases

Load Combinations
9.3.3 Concise Report

The concise report is the short version of the report that includes all information necessary to describe project input and results.

Sections of concise report are:

- Project Design Parameters
- Design Strip Reports

Project Design Parameters includes information common to the entire project and can be printed as evidence that data in design criteria was properly entered into the program. It includes:

- Material properties
- Covers
- Code
- Load combinations
- Other common entries for all support lines.

Design Strip Report includes:

- Definition of geometry (annotated graphics)
- Applied loads (annotated graphics)
- Design Moment (annotated graphics)
- Rebar report
- Punching shear
- Deflection graph
- Quantities

The following is the example of concise report:
A. Design Parameters and Load Combinations

A.1 Project Design Parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete</td>
<td></td>
<td>Fy (Shear reinforcement)</td>
<td>60.00 ksi</td>
</tr>
<tr>
<td>F’c for BEAMS/SLABS</td>
<td>4000.00 psi</td>
<td>Minimum Cover at TOP</td>
<td>1.00 in</td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>4000.00 psi</td>
<td>Minimum Cover at BOTTOM</td>
<td>1.00 in</td>
</tr>
<tr>
<td>Ec for BEAMS/SLABS</td>
<td>3605.00 ksi</td>
<td>Analysis and design options</td>
<td></td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>3605.00 ksi</td>
<td>Structural system</td>
<td>TWO-WAY</td>
</tr>
<tr>
<td>CREEP factor</td>
<td>2.00</td>
<td>Moment of Inertia over support is</td>
<td>INCREASED</td>
</tr>
<tr>
<td>CONCRETE WEIGHT</td>
<td>NORMAL</td>
<td>Moments reduced to face of support</td>
<td>YES</td>
</tr>
<tr>
<td>Reinforcement</td>
<td></td>
<td>Moment Redistribution</td>
<td>NO</td>
</tr>
<tr>
<td>Fy (Main bars)</td>
<td>60.00 ksi</td>
<td>DESIGN CODE SELECTED</td>
<td>ACI-318 (2005)</td>
</tr>
</tbody>
</table>

A.2 Load Combinations

Strength load combinations
1. 1.2 SW + 1.6 LL + 1.2 SDL + 1.6 X

Lateral load combinations:
1. U = 1.2 SW + 1 LL + 1.2 SDL + 1 Lat
2. U = 0.9 SW + 0.9 SDL + 1 Lat

B. Design Strip Report: TWO-WAY THREE SPAN

B.1 Geometry

- Plan

- Elevation
B.2 Applied loads

- Superimposed Dead Load

- Live Load

- Lateral Load
B.3 Design Moment

LOAD COMBINATION: Envelope

DESIGN MOMENT
(Moment is drawn on tension side)

B.6 Rebar Report

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>TOP</td>
<td>10.50</td>
<td>21</td>
<td>5</td>
<td>16.50</td>
<td>6.51</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>TOP</td>
<td>16.66</td>
<td>24</td>
<td>5</td>
<td>18.50</td>
<td>7.44</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>TOP</td>
<td>17.20</td>
<td>7</td>
<td>5</td>
<td>9.50</td>
<td>2.17</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>TOP</td>
<td>14.33</td>
<td>20</td>
<td>5</td>
<td>10.00</td>
<td>6.20</td>
</tr>
<tr>
<td>2</td>
<td>5</td>
<td>TOP</td>
<td>22.09</td>
<td>24</td>
<td>5</td>
<td>9.50</td>
<td>7.44</td>
</tr>
<tr>
<td>3</td>
<td>6</td>
<td>TOP</td>
<td>20.61</td>
<td>6</td>
<td>5</td>
<td>6.00</td>
<td>1.86</td>
</tr>
<tr>
<td>1</td>
<td>7</td>
<td>BOT</td>
<td>0.00</td>
<td>7</td>
<td>8</td>
<td>14.50</td>
<td>5.53</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>BOT</td>
<td>1.72</td>
<td>4</td>
<td>8</td>
<td>21.00</td>
<td>3.16</td>
</tr>
<tr>
<td>3</td>
<td>9</td>
<td>BOT</td>
<td>3.55</td>
<td>5</td>
<td>8</td>
<td>20.00</td>
<td>3.95</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>4.43</td>
<td>4</td>
<td>8</td>
<td>18.50</td>
<td>3.16</td>
</tr>
<tr>
<td>3</td>
<td>11</td>
<td>BOT</td>
<td>6.96</td>
<td>4</td>
<td>8</td>
<td>14.50</td>
<td>3.16</td>
</tr>
</tbody>
</table>

B.7 Punching Shear

<table>
<thead>
<tr>
<th>Label</th>
<th>Layer</th>
<th>Cond.</th>
<th>Factored shear</th>
<th>Factored moment</th>
<th>Stress due to shear</th>
<th>Stress due to moment</th>
<th>Total stress</th>
<th>Allowable stress</th>
<th>Stress ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>1</td>
<td>-194.05</td>
<td>-186.80</td>
<td>0.10</td>
<td>0.022</td>
<td>0.117</td>
<td>0.160</td>
<td>0.732</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>1</td>
<td>-203.49</td>
<td>-188.34</td>
<td>0.10</td>
<td>0.022</td>
<td>0.122</td>
<td>0.160</td>
<td>0.762</td>
</tr>
<tr>
<td>4</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>

Punching Shear Reinforcement
Reinforcement option: Stirrups
Bar Size: 5
### B.8 Deflection

![Deflection Diagrams](image)

**DEFLECTION**

### B.9 Quantities

**CONCRETE**
- Total volume of concrete = 1113.85 ft³ (41.25 yd³)
- Area covered = 1306.62 ft²

**MILD STEEL**
- Total weight of rebar = 2519.23 lbs
- Average rebar usage = 1.93 psf, 2.26 pcf

#### 9.3.4 Compact Report

The compact report consists of the mirror image of user input, plus a tabular listing of critical information, such as reinforcement, necessary for preparation of structural drawings. Also, it includes values of actions, such as moments and shears at left center and right of each span.

The following is the description of the available report sections:
9.3.4.1 Section 1- User Specified General Analysis and Design Parameters

This data block reflects the user’s input in the selection of design parameters and the design options.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Concrete</td>
<td>Fy (Shear reinforcement)</td>
<td>60.00 ksi</td>
<td></td>
</tr>
<tr>
<td>F’c for BEAMS/SLABS</td>
<td>4000.00 psi</td>
<td>Minimum Cover at TOP</td>
<td>1.00 in</td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>4000.00 psi</td>
<td>Minimum Cover at BOTTOM</td>
<td>1.00 in</td>
</tr>
<tr>
<td>Ec for BEAMS/SLABS</td>
<td>3605.00 ksi</td>
<td>Analysis and design options</td>
<td></td>
</tr>
<tr>
<td>For COLUMNS/WALLS</td>
<td>3605.00 ksi</td>
<td>Structural system</td>
<td>TWO-WAY</td>
</tr>
<tr>
<td>CREEP factor</td>
<td>2.00</td>
<td>Moment of Inertia over support is</td>
<td>INCREASED</td>
</tr>
<tr>
<td>CONCRETE WEIGHT</td>
<td>NORMAL</td>
<td>Moments reduced to face of support</td>
<td>YES</td>
</tr>
<tr>
<td>Reinforcement</td>
<td></td>
<td>Moment Redistribution</td>
<td>NO</td>
</tr>
<tr>
<td>Fy (Main bars)</td>
<td>60.00 ksi</td>
<td>DESIGN CODE SELECTED</td>
<td>ACI-318 (2005)</td>
</tr>
</tbody>
</table>

The parameters listed in this data block are used in the design as shown which cannot be changed during the execution. The execution should be performed after any changes in the parameters are made.

The following is the description of the data:

- Concrete: This data block refers to the properties of the concrete, such as the concrete strength, modulus of elasticity, of beam/slab/column.

- Reinforcement: This data block refers to the non-prestressed reinforcement in the beam/slab. The values for beam stirrups, where applicable, are given in Section 12 of the report.

- Analysis option used: This block will be different based on the structural system selected. If the answer to moments reduced to face-of-support is YES, it indicates that the calculated centerline moments at each support are adjusted to face-of-support. In addition to the centerline moments, ADAPT prints out the moments reduced to face-of-support. Refer to moment data blocks for the description of printed values.

- Moment of Inertia over support: The beam or slab region over the width of a support (columns or walls) exhibits a greater stiffness than the unsupported regions. ADAPT has an option to allow for this greater stiffness by increasing the moment of inertia of region over the support. The
increase is determined by a relationship proposed in ACI-318.

9.3.4.2 Section 2: Input Geometry

This data block reports model geometry as input by the user. It includes basic span geometry, effective width used in calculations, drop cap, drop panel, transfer beam dimensions as well as support width and column dimensions. The geometry is described as follows:

2.1 Principal Span Data of Uniform Spans. This section is available only if the user selects conventional geometry input.

<table>
<thead>
<tr>
<th>Span</th>
<th>Form</th>
<th>Length</th>
<th>Width</th>
<th>Depth</th>
<th>TF Width</th>
<th>TF Thick.</th>
<th>BF/MF Width</th>
<th>BF/MF Thick.</th>
<th>Rh</th>
<th>Right Mult.</th>
<th>Left Mult.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>19.17</td>
<td>12.00</td>
<td>10.00</td>
<td>0.00</td>
<td>10.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>27.17</td>
<td>12.00</td>
<td>10.00</td>
<td>0.00</td>
<td>10.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>22.75</td>
<td>12.00</td>
<td>10.00</td>
<td>0.00</td>
<td>10.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>1</td>
<td>3.50</td>
<td>12.00</td>
<td>10.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2.2 Detailed Data for Nonuniform Spans. This section is available only if the user selects segmental geometry input.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>0.00</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>0</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>2</td>
<td>0.33</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>0</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>2</td>
<td>5.00</td>
<td>24.00</td>
<td>30.00</td>
<td>216.00</td>
<td>8.00</td>
<td></td>
<td></td>
<td>0</td>
<td>0.56</td>
<td>0.44</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>1</td>
<td>18.42</td>
<td>24.00</td>
<td>30.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>0</td>
<td>0.50</td>
<td>0.50</td>
</tr>
</tbody>
</table>

The following is the description of the data:

Span. This column shows the span number (ID). If the structure has a cantilever at left, its data precedes the first span by a line starting with “C.” Likewise, in the case of a cantilever at right, the last line will start with “C” describing the geometry of the right cantilever.

Seg. This column shows the segment number (ID).

Form. Identifies the cross-sectional geometry of the slab at midspan. Figure 9.3-2 illustrates the cross-sectional options. The
same figure also gives the definition of parameters Depth, Width, TF Width (top flange width), TF Thick. (Top flange thickness), BF/MF Width (bottom flange/middle flange width) and BF/MF Thick. (bottom flange/middle flange thickness).

<table>
<thead>
<tr>
<th>TYPE</th>
<th>CROSS-SECTIONAL GEOMETRIES</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 RECTANGLE SECTION</td>
<td>WIDTH</td>
</tr>
<tr>
<td>2 T OR I SECTION</td>
<td>FLANGE WIDTH</td>
</tr>
<tr>
<td>3 H-MH-35 SECTION</td>
<td>TOP FLANGE WIDTH</td>
</tr>
<tr>
<td>4 EXTENDED T OR I SECTION</td>
<td>TOP FLANGE WIDTH</td>
</tr>
</tbody>
</table>

**FIGURE 9.3-2**

**Length.** The centerline-to-centerline distance between adjacent supports for each span.

**Rh (Reference height).** The distance from a user-specified reference line to top of the slab. For example, if a slab is 10” thick and Rh is set to 10”, the datum is located at the slab soffit. This data is used to input the steps in a member.

**Right or Left (Width) Multiplier.** A parameter which used to specify the tributary width to indicate how much of the tributary
falls on either side of the frame line. Tributary widths can be specified using either the “Unit Strip” method or the “Tributary method”.

It should be noted that the results printed in the output, such as the moments and reactions, refer to the total tributary unless indicated otherwise.

2.3 Effective Width Data of Uniform Spans. This section applies to Conventional geometry input. Note that this section will be available only for beams

<table>
<thead>
<tr>
<th>Span</th>
<th>Effective Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>57.51</td>
</tr>
<tr>
<td>2</td>
<td>81.51</td>
</tr>
<tr>
<td>3</td>
<td>68.25</td>
</tr>
</tbody>
</table>

Effective Width Data for Non-Uniform Spans. This section applies to Segmental geometry input.

<table>
<thead>
<tr>
<th>Span</th>
<th>Seg.</th>
<th>Effective Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>57.51</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>57.51</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>57.51</td>
</tr>
</tbody>
</table>

Span. This column shows the span number (ID). If the structure has a cantilever at left, its data precedes the first span by a line starting with “C”. Likewise, in the case of a cantilever at right, the last line will start with “C” describing the geometry of the right cantilever.

Seg. This column shows the segment number (ID).

Effective width. Mirrors the data in the Geometry-Effective Flange width input form

2.5 Drop Cap and Drop Panel Data. This data block gives the dimensions of drop caps/panels for each support. Figure 9.3-4 illustrates the definition of data columns 2 through 10.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Cap T</th>
<th>Cap B</th>
<th>Cap DL</th>
<th>Cap DR</th>
<th>Drop TL</th>
<th>Drop TR</th>
<th>Drop B</th>
<th>Drop L</th>
<th>Drop R</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>36.00</td>
<td>48.00</td>
<td>0.00</td>
<td>24.00</td>
<td>0.00</td>
<td>30.00</td>
<td>100.00</td>
<td>0.00</td>
<td>50.00</td>
</tr>
<tr>
<td>2</td>
<td>36.00</td>
<td>48.00</td>
<td>24.00</td>
<td>24.00</td>
<td>24.00</td>
<td>30.00</td>
<td>100.00</td>
<td>50.00</td>
<td>50.00</td>
</tr>
</tbody>
</table>
For example, Cap T, which is the heading of column 2, is shown at the bottom right hand side of Fig. 9.3-4 to indicate the total depth of “CAP.” STEP 1 in the figure indicates the first thickening of the slab past the support, and is referred to as DROP CAP regardless of its size. The second change in thickness is called DROP PANEL, or STEP 2.

If no drop caps or panels are present, zeros are shown in this data block. A zero indicates that the user has not entered any value for a parameter. However, as far as the computations are concerned, ADAPT selects a minimum default value if necessary. For example, CAPT equal zero will result in a default value of CAPT equals span thickness for calculations.

2.6 Transverse Beam Data. Transverse beam data are reported in the table of Section 2.5.
2.7 Support Width and Column Data. This data block is only printed if columns data are input, or if support widths are specified for reduction of moments to face-of-support. Otherwise zeros are shown in this data block.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Support Width</th>
<th>Length LC</th>
<th>B(DIA.) LC</th>
<th>D LC</th>
<th>% LC</th>
<th>CBC LC</th>
<th>Length UC</th>
<th>B(DIA.) UC</th>
<th>D UC</th>
<th>% UC</th>
<th>CBC UC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>8.0</td>
<td>10.0</td>
<td>216.0</td>
<td>8.0</td>
<td>100</td>
<td>(2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>18.0</td>
<td>10.0</td>
<td>12.0</td>
<td>18.0</td>
<td>100</td>
<td>(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>18.0</td>
<td>10.0</td>
<td>12.0</td>
<td>18.0</td>
<td>100</td>
<td>(1)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>8.0</td>
<td>10.0</td>
<td>216.0</td>
<td>8.0</td>
<td>100</td>
<td>(2)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Support Width - is the support width at each joint. These values are used in the reduction of moments to the face-of-support. This value may be different from the column dimensions.

Length LC – is the height of the lower column measured from the center of the slab to the top of the bottom slab.

Length UC- is the height of the upper column measured from the center of the slab to the bottom of the top slab.

B(DIA) - is the dimension of the column cross-section normal to the direction of the frame. A circular column is entered using B(DIA) only.

D - is the column dimension parallel to the frame.

CBC is the Column Boundary Condition parameter. B and D can also describe the horizontal dimensions of the structural element supporting the slab, such as the thickness and length of a continuous wall. Whether or not a given wall/column support dimensioned through B and D is taking moments is determined by the manner in which the wall/column is connected to the slab. The nature of the connection of the support to the slab at the slab/support junction is indicated by the CBC parameter as defined by the user and reflected in columns 7 and 12 of this data block. Note that the CBC parameter also describes the condition of fixity of the column at its far end away from the beam/slab, namely at its connection to the slab above and the slab/footing below.

% is the percentage of the column stiffness included in the analysis.
9.3.4.3 Section 3: Input Applied Loading

This data block reports model loads as input by the user. Loads entered by the user are sorted according to the span on which they act and are listed in the loading data block.

3.1 Loading As Appears in User's Input Screen. This section mirrors the data as shown in the Loads input screen.

<table>
<thead>
<tr>
<th>Span</th>
<th>Class</th>
<th>Type</th>
<th>W</th>
<th>P1</th>
<th>P2</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>F</th>
<th>M</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LL</td>
<td>U</td>
<td>0.120</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>SDL</td>
<td>U</td>
<td>0.250</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3.2 Compiled loads. This section shows frame line loads calculated by the program. If you specified uniformly distributed or partial loadings, the program will calculate frame loading based on the tributary width.

<table>
<thead>
<tr>
<th>Span</th>
<th>Class</th>
<th>Type</th>
<th>P1</th>
<th>P2</th>
<th>F</th>
<th>M</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>Reduction Factor</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>LL</td>
<td>P</td>
<td>2.160</td>
<td></td>
<td>k</td>
<td></td>
<td>0.000</td>
<td>19.170</td>
<td></td>
<td>0.000</td>
</tr>
<tr>
<td>1</td>
<td>SDL</td>
<td>P</td>
<td>4.500</td>
<td></td>
<td></td>
<td></td>
<td>0.000</td>
<td>19.170</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Class.** Specifies load class for each span. Class LL is live load, class SDL is superimposed dead load, class SW is selfweight and class X is other loading.

**Type.** There are 8 different load types:

- **U** is for uniformly distributed load acting on the entire tributary.
- **C** is for a concentrated load. It acts at a point entered by the user and measured from the left support of the respective span.
- **P** is for a partial uniform load that acts on the entire width (tributary) of a span over the length entered by the user.
- **M** is for an applied moment that acts on the entire tributary at a distance from the left support entered by the user.
- **L** is for a Line load that acts along the frame line of the slab. Line loads are entered in the same manner as partial loads.
• **R** is for triangle load that acts along the frame line of the slab.

• **V** is for variable load that acts along the frame line of the slab.

• **Z** is for trapezoidal load that acts along the frame line of the slab.

The user can also select the selfweight option. Using the geometry and unit weight entered by the user, ADAPT calculates the selfweight of the entire beam/slab and automatically amends the loading file. The value of the selfweight loading will appear in the output data.

Live load is not skipped unless stipulated by the user, in which case the following sentence appears at the end of the loading table:

LIVE LOADING is SKIPPED with a skip factor of x.xx

The skip factor specified by the user will appear in lieu of x.xx shown above.

When the skip load option is activated, ADAPT obtains two sets of solutions. (i) In the first set, live loading is assumed to act without the skip factor on all spans. (ii) In the second set, live load multiplied by the specified skip factor is selectively placed on different spans. Solutions of the second set are combined to yield the maximum possible negative and positive moments at each location. Results of moment combinations from (i) and (ii) are then merged to arrive at the governing moments for design.

### 9.3.4.4 Section 4: Calculated Section Properties

The data block of section properties gives the cross-sectional area, moment of inertia, and the location of the neutral axis of the entire tributary perpendicular to the direction of the span.

**Section Properties of Uniform Spans and Cantilevers.**

The table below shows the data for rectangular cross-sections.

<table>
<thead>
<tr>
<th>Span</th>
<th>Area</th>
<th>I</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in²</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>2160.00</td>
<td>0.18E+05</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>2</td>
<td>2160.00</td>
<td>0.18E+05</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>3</td>
<td>2160.00</td>
<td>0.18E+05</td>
<td>5.00</td>
<td>5.00</td>
</tr>
</tbody>
</table>
In the case of flanged T-beams, there are two cross-sectional properties computed. One is for the section reduced by “effective” width, and the other is for the entire tributary. The reduced values are used for flexure of the member and the total values for inplane (axial) loads. The Section 4.1 is then as shown below.

<table>
<thead>
<tr>
<th>Span</th>
<th>Area</th>
<th>Yb</th>
<th>Yt</th>
<th>b_eff</th>
<th>i</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in²</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.6052E+07</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>2</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.2421E+06</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>3</td>
<td>4160.00</td>
<td>17.79</td>
<td>12.21</td>
<td>100.00</td>
<td>0.2250E+06</td>
<td>15.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

**Section Properties for Non-Uniform Spans.** The table below shows the data for rectangular cross-sections.

<table>
<thead>
<tr>
<th>Span</th>
<th>Segment</th>
<th>Area</th>
<th>I</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in²</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>2160.00</td>
<td>0.45E+06</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>2160.00</td>
<td>0.18E+06</td>
<td>5.00</td>
<td>5.00</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>1944.00</td>
<td>0.13E+05</td>
<td>4.50</td>
<td>4.50</td>
</tr>
</tbody>
</table>

For T-flanged beams the data are shown as follows:

<table>
<thead>
<tr>
<th>Span</th>
<th>Segment</th>
<th>Area</th>
<th>Yb</th>
<th>Yt</th>
<th>b_eff</th>
<th>i</th>
<th>Yb</th>
<th>Yt</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in²</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in⁴</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.6052E+07</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4448.00</td>
<td>22.44</td>
<td>13.56</td>
<td>57.51</td>
<td>0.2421E+06</td>
<td>17.71</td>
<td>18.29</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>4160.00</td>
<td>17.79</td>
<td>12.21</td>
<td>100.00</td>
<td>0.2250E+06</td>
<td>15.00</td>
<td>15.00</td>
</tr>
</tbody>
</table>

The calculated section properties are given in terms of span segments, for both customary and segmental input geometries. A non-segmental span with no drop caps or drop panels has one segment. A span with drop caps at either end has three segments. A span with drop caps and drop panels has five segments. Finally, a segmental span can have up to seven segments.

Yt and Yb refer to the distance of the neutral axis to the top and bottom fibers.

When there is a change in cross-section of a span at the line of support, as shown in the idealized **Fig. 9.3-5(a),** two options regarding the face-of-support arise. Over the support line, ADAPT considers the cross-section at the face-of-support of the shallower member to be the same as that of the deeper member. But, recognizing that the deeper span does not penetrate into the
shallower one, ADAPT assumes a zero length for the geometry of the deeper section into the shallower span. The same assumption is used for change of geometry over the supports of finite width as shown in Fig. 9.3-5(b).

![Idealized Support and Finite Support](image)

**FIGURE 9.3-5**

If the analysis is done with finite support widths, and the user has included the option to increase moment of inertia over the support, then ADAPT adds an additional segment over each support.

### 9.3.4.5 Section 5: Moments, Shears and Reactions

Values given as moments, shears and reactions all refer to the *total tributary* and not the unit strip. Moments in this data block are moments at the center of supports (system line moments).

#### 5.1 Span Moments and Shears (Excluding Live Load)

<table>
<thead>
<tr>
<th>Span</th>
<th>Load Case</th>
<th>Moment Left</th>
<th>Moment Midspan</th>
<th>Moment Right</th>
<th>Shear Left</th>
<th>Shear Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDL</td>
<td>0.00</td>
<td>72.77</td>
<td>-267.88</td>
<td>-29.16</td>
<td>57.11</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>-279.04</td>
<td>116.54</td>
<td>-318.35</td>
<td>-59.69</td>
<td>62.58</td>
</tr>
</tbody>
</table>

Moment Left and Moment Right relate to centerline moments in the slab at the left and right of each span respectively.

Moment Midspan refers to the moment at midspan. The moment at midspan is not necessarily the largest value. For the location and value of the maximum moment refer to Section 23 that gives detailed report at 1/20th points.
Shear Left and Shear Right are the centerline shear forces at the left and right of each span.

5.2 Reactions and Column Moments (Excluding Live Load)

<table>
<thead>
<tr>
<th>Joint</th>
<th>Load Case</th>
<th>Reaction</th>
<th>Moment Lower Column</th>
<th>Moment Upper Column</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>SDL</td>
<td>29.16</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>116.79</td>
<td>-11.16</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Reaction is the centerline dead load reaction at each support line.

Moment Lower Column and Moment Upper Column are upper and lower dead load column moments and are given for each support at the connection of column to slab/beam. If a support does not have a column, or if moment transfer between the support and slab is inhibited by the user through the specification of an appropriate column boundary condition, a zero (0) is printed.

Live load moments, shears and reactions are values reported at the center of supports and refer to the entire tributary.

5.3 Span Moments and Shears (Live Load). This section is a summary of maximum and minimum live load moments, and corresponding shear forces at the left and right centerlines, as well as at center span.

<table>
<thead>
<tr>
<th>Span</th>
<th>Moment Left Max</th>
<th>Moment Left Min</th>
<th>Moment Midspan Max</th>
<th>Moment Midspan Min</th>
<th>Moment Right Max</th>
<th>Moment Right Min</th>
<th>Shear Left</th>
<th>Shear Right</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k</td>
<td>k</td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.00</td>
<td>40.40</td>
<td>40.40</td>
<td>-117.64</td>
<td>-117.64</td>
<td>-14.57</td>
<td>26.84</td>
</tr>
<tr>
<td>2</td>
<td>-116.53</td>
<td>-116.53</td>
<td>43.03</td>
<td>43.03</td>
<td>-129.61</td>
<td>-129.61</td>
<td>-23.97</td>
<td>24.93</td>
</tr>
</tbody>
</table>

Maximum and minimum values at a section may occur due to the skipping of live loading.

5.4 Reactions and Column Moments (Live Load). This section is a summary of the maximum and minimum live load reactions and column moments given for each support at the connection of column to slab/beam.
If a support does not have a column, or if moment transfer between the support and slab is inhibited by the user through the specification of an appropriate column boundary condition, a zero (0) is printed in the “moment” columns.

These are minimum and maximum centerline values based on skipped loading case.

Values given as moments, shears and reactions all refer to the total tributary and not the unit strip. Moments in this data block are system line moments.

9.3.4.6 Section 6: Moments Reduced to Face of Support

If the option of reducing moments to the face-of-support is invoked by the user, ADAPT adjusts the centerline moments to the face-of-support. The adjustments are based primarily on support widths. The adjusted values are printed in Sections 6.1 and 6.2. If this data block does not appear on the report, it signifies that the reduction of moments to the face of support has not been requested by the user.

6.1 Reduced Moments at Face of Support (Excluding Live Load)

<table>
<thead>
<tr>
<th>Span</th>
<th>Load Case</th>
<th>Moment Left Max</th>
<th>Moment Left Min</th>
<th>Moment Midspan Max</th>
<th>Moment Midspan Min</th>
<th>Moment Right Max</th>
<th>Moment Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>SDL</td>
<td>9.47</td>
<td>4.74</td>
<td>40.40</td>
<td>40.40</td>
<td>-98.08</td>
<td>-98.08</td>
</tr>
<tr>
<td>2</td>
<td>SDL</td>
<td>-235.58</td>
<td>-99.08</td>
<td>43.02</td>
<td>43.02</td>
<td>-111.42</td>
<td>-111.42</td>
</tr>
</tbody>
</table>

6.2 Reduced Moments at Face of Support (Live Load)

<table>
<thead>
<tr>
<th>Span</th>
<th>Moment Left Max</th>
<th>Moment Left Min</th>
<th>Moment Midspan Max</th>
<th>Moment Midspan Min</th>
<th>Moment Right Max</th>
<th>Moment Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>4.74</td>
<td>4.74</td>
<td>40.40</td>
<td>40.40</td>
<td>-98.08</td>
<td>-98.08</td>
</tr>
<tr>
<td>2</td>
<td>-99.08</td>
<td>-99.08</td>
<td>43.02</td>
<td>43.02</td>
<td>-111.42</td>
<td>-111.42</td>
</tr>
</tbody>
</table>
9.3.4.7 Section 8: Factored Moments and Reactions Envelope

This data block lists the duly combined actions for the evaluation of the member’s ultimate strength.

8.1 Factored Design Moments (Not Redistributed). The factored and combined actions, or design actions, are the sum of dead loading and live loading, each multiplied by a coefficient. If reduction to face-of-support is invoked by the user, the factored moments given relate to face-of-support; else, they represent centerline moments.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>18.94</td>
<td>18.94</td>
<td>151.97</td>
<td>151.97</td>
<td>-428.53</td>
<td>-428.53</td>
</tr>
<tr>
<td>2</td>
<td>-441.23</td>
<td>-441.23</td>
<td>208.74</td>
<td>208.74</td>
<td>-505.47</td>
<td>-505.47</td>
</tr>
</tbody>
</table>

8.2 Reactions and Column Moments. The factored support reactions are printed for the unit strip as defined in columns 4 through 7 of data block 2.1, and for the entire tributary, in columns 2 & 3 of data block 8.2. The factored support moments are given in columns 4 through 7 of data block 8.2.

<table>
<thead>
<tr>
<th>Joint</th>
<th>Reaction Max</th>
<th>Reaction Min</th>
<th>Moment Lower Column Max</th>
<th>Moment Lower Column Min</th>
<th>Moment Upper Column Max</th>
<th>Moment Upper Column Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k</td>
<td>k</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>58.30</td>
<td>58.30</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>221.46</td>
<td>221.46</td>
<td>-11.61</td>
<td>-11.61</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>236.66</td>
<td>236.66</td>
<td>-14.38</td>
<td>-14.38</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

For the design of columns, total factored reactions and factored column moments are normally used. If design handbooks are used for column design, the relating eccentricity of the axial loading commonly required for use in such handbooks is readily obtained by dividing the printed factored column moment by the corresponding total factored reaction. Shears, reactions and column moments are centerline values.

8.4 Factored Design Moments (Redistributed). This section shows the moments listed in Section 8.1 after redistribution. This section is available only if you selected to redistribute moments.
9.3.4.8 Section 9: Factored Lateral Moments Envelope

This section shows the results for the combination of lateral and gravity moments.

9.1 Input Lateral Moments. This section mirrors the input data specified in the Lateral Input Data screen.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
<th>Redist. Coef. Left</th>
<th>Redist. Coef Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>20.45</td>
<td>20.45</td>
<td>191.50</td>
<td>191.50</td>
<td>-359.88</td>
<td>-359.88</td>
<td>0.00</td>
<td>17.49</td>
</tr>
<tr>
<td>2</td>
<td>-357.28</td>
<td>-357.28</td>
<td>293.54</td>
<td>293.54</td>
<td>-433.34</td>
<td>-433.34</td>
<td>20.00</td>
<td>14.93</td>
</tr>
<tr>
<td>3</td>
<td>-436.56</td>
<td>-436.56</td>
<td>271.58</td>
<td>271.58</td>
<td>-27.57</td>
<td>-27.57</td>
<td>16.67</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

9.2 Factored Lateral Moments (Not Redistributed). This section shows factored and combined actions of dead loading, live loading, and lateral moments each multiplied by a coefficient.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
<th>Redist. Coef. Left</th>
<th>Redist. Coef Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>+112.63</td>
<td>+105.05</td>
<td>+127.94</td>
<td>+65.69</td>
<td>-461.53</td>
<td>-295.50</td>
<td>0.00</td>
<td>20.00</td>
</tr>
<tr>
<td>2</td>
<td>-287.80</td>
<td>-117.92</td>
<td>+182.91</td>
<td>+104.85</td>
<td>-532.55</td>
<td>-339.66</td>
<td>-20.00</td>
<td>20.00</td>
</tr>
</tbody>
</table>

9.3 Factored Lateral Moments (Redistributed). These section shows moments listed in Section 9.2 after redistribution. This section is available only if you selected to redistribute moments.

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
<th>Redist. Coef. Left</th>
<th>Redist. Coef Right</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>115.32</td>
<td>107.14</td>
<td>174.24</td>
<td>96.19</td>
<td>-379.63</td>
<td>-241.10</td>
<td>0.00</td>
<td>20.00</td>
</tr>
<tr>
<td>2</td>
<td>-344.82</td>
<td>-140.37</td>
<td>199.06</td>
<td>128.29</td>
<td>-455.10</td>
<td>-276.99</td>
<td>-20.00</td>
<td>20.00</td>
</tr>
<tr>
<td>3</td>
<td>-425.00</td>
<td>-186.19</td>
<td>159.82</td>
<td>90.02</td>
<td>-123.96</td>
<td>-112.19</td>
<td>-20.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

If reduction to face-of-support is invoked by the user, the factored moments given relate to face-of-support; else, they represent centerline moments.
9.3.4.9 Section 10: Mild Steel - No Redistribution

The mild reinforcement is calculated on the basis of one of the following criteria:

- One-way systems; and
- Two-way systems.

The applicable set of criteria is invoked by the user through the choice of the structural system (one-way or two-way). The user’s selection is shown clearly in data block 1.

10.1 Required Rebar. This section shows required rebar based on ultimate and minimum criteria. It lists the rebar required for the total strip, column strip, and middle strip in each table from section 10.1.1 through section 10.1.3. Column strip and middle strip rebar are distributed based on the user selection during input.

### 10.1.1 Total Strip Required Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>To</th>
<th>As Required</th>
<th>Ultimate</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>ft</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>12.46</td>
<td>19.17</td>
<td>12.61</td>
<td>12.61</td>
<td>3.89</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>5.43</td>
<td>11.98</td>
<td>11.98</td>
<td>3.89</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>19.02</td>
<td>27.17</td>
<td>14.71</td>
<td>14.71</td>
<td>3.89</td>
</tr>
<tr>
<td>1</td>
<td>BOT</td>
<td>0.00</td>
<td>12.46</td>
<td>5.43</td>
<td>5.43</td>
<td>3.89</td>
</tr>
<tr>
<td>2</td>
<td>BOT</td>
<td>4.07</td>
<td>20.38</td>
<td>5.71</td>
<td>5.71</td>
<td>3.89</td>
</tr>
</tbody>
</table>

### 10.1.2 Column Strip Required Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>To</th>
<th>As Required</th>
<th>Ultimate</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>ft</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>12.46</td>
<td>19.17</td>
<td>9.46</td>
<td>9.46</td>
<td>2.92</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>5.43</td>
<td>8.98</td>
<td>8.98</td>
<td>2.92</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>19.02</td>
<td>27.17</td>
<td>11.03</td>
<td>11.03</td>
<td>2.92</td>
</tr>
<tr>
<td>1</td>
<td>BOT</td>
<td>0.00</td>
<td>12.46</td>
<td>3.26</td>
<td>3.26</td>
<td>2.34</td>
</tr>
<tr>
<td>2</td>
<td>BOT</td>
<td>4.07</td>
<td>20.38</td>
<td>3.43</td>
<td>3.43</td>
<td>2.34</td>
</tr>
</tbody>
</table>

### 10.1.3 Middle Strip Required Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>To</th>
<th>As Required</th>
<th>Ultimate</th>
<th>Minimum</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>ft</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>12.46</td>
<td>19.17</td>
<td>3.15</td>
<td>3.15</td>
<td>0.97</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>6.79</td>
<td>3.27</td>
<td>3.27</td>
<td>0.97</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>19.02</td>
<td>27.17</td>
<td>3.68</td>
<td>3.68</td>
<td>0.97</td>
</tr>
<tr>
<td>1</td>
<td>BOT</td>
<td>0.00</td>
<td>14.38</td>
<td>2.17</td>
<td>2.17</td>
<td>1.56</td>
</tr>
<tr>
<td>2</td>
<td>BOT</td>
<td>4.07</td>
<td>21.74</td>
<td>2.28</td>
<td>2.28</td>
<td>1.56</td>
</tr>
</tbody>
</table>

### 10.2 Provided Rebar. This section lists the provided rebar details.

### 10.2.1 Total Strip Provided Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
</table>
### 10.2.2 Total Strip Steel Disposition

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TOP</td>
<td>10.50</td>
<td>22</td>
<td>5</td>
<td>18.00</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>16.66</td>
<td>25</td>
<td>5</td>
<td>19.50</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>3.00</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>TOP</td>
<td>14.33</td>
<td>21</td>
<td>5</td>
<td>10.00</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>TOP</td>
<td>22.09</td>
<td>24</td>
<td>5</td>
<td>9.50</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>BOT</td>
<td>0.00</td>
<td>4</td>
<td>8</td>
<td>16.50</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>1.72</td>
<td>4</td>
<td>8</td>
<td>22.50</td>
</tr>
<tr>
<td>1</td>
<td>12</td>
<td>BOT</td>
<td>0.00</td>
<td>3</td>
<td>8</td>
<td>15.50</td>
</tr>
<tr>
<td>2</td>
<td>13</td>
<td>BOT</td>
<td>4.43</td>
<td>4</td>
<td>8</td>
<td>18.50</td>
</tr>
</tbody>
</table>

### 10.2.3 Column Strip Provided Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>5.00</td>
<td>1.24</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TOP</td>
<td>10.50</td>
<td>22</td>
<td>5</td>
<td>18.00</td>
<td>5.27</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>16.66</td>
<td>19</td>
<td>5</td>
<td>19.50</td>
<td>5.89</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>3.00</td>
<td>1.24</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>TOP</td>
<td>14.33</td>
<td>16</td>
<td>5</td>
<td>10.00</td>
<td>4.96</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>TOP</td>
<td>22.09</td>
<td>18</td>
<td>5</td>
<td>9.50</td>
<td>5.58</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>16.50</td>
<td>1.58</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>1.72</td>
<td>2</td>
<td>8</td>
<td>22.50</td>
<td>1.58</td>
</tr>
<tr>
<td>1</td>
<td>12</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>15.50</td>
<td>1.58</td>
</tr>
<tr>
<td>2</td>
<td>13</td>
<td>BOT</td>
<td>4.43</td>
<td>2</td>
<td>8</td>
<td>18.50</td>
<td>1.58</td>
</tr>
</tbody>
</table>

### 10.2.4 Column Strip Steel Disposition

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>1</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>5.00</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TOP</td>
<td>10.50</td>
<td>17</td>
<td>5</td>
<td>8.67</td>
</tr>
<tr>
<td>1</td>
<td>5</td>
<td>TOP</td>
<td>0.00</td>
<td>4</td>
<td>5</td>
<td>3.00</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>TOP</td>
<td>14.33</td>
<td>16</td>
<td>5</td>
<td>4.84</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>17</td>
<td>5</td>
<td>9.33</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>16.66</td>
<td>19</td>
<td>5</td>
<td>10.51</td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>TOP</td>
<td>0.00</td>
<td>16</td>
<td>5</td>
<td>5.16</td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>TOP</td>
<td>22.09</td>
<td>18</td>
<td>5</td>
<td>5.08</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>16.50</td>
</tr>
<tr>
<td>1</td>
<td>12</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>15.50</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>1.72</td>
<td>2</td>
<td>8</td>
<td>22.50</td>
</tr>
<tr>
<td>2</td>
<td>13</td>
<td>BOT</td>
<td>4.43</td>
<td>2</td>
<td>8</td>
<td>18.50</td>
</tr>
</tbody>
</table>
10.2.5 Middle Strip Provided Rebar

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>TOP</td>
<td>ft</td>
<td></td>
<td></td>
<td>18.00</td>
<td>1.55</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TOP</td>
<td>10.50</td>
<td>5</td>
<td>5</td>
<td>19.50</td>
<td>1.86</td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>14.33</td>
<td>5</td>
<td>5</td>
<td>10.00</td>
<td>1.55</td>
</tr>
<tr>
<td>1</td>
<td>6</td>
<td>TOP</td>
<td>22.99</td>
<td>6</td>
<td>5</td>
<td>9.50</td>
<td>1.86</td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>16.50</td>
<td>1.58</td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>1.72</td>
<td>2</td>
<td>8</td>
<td>22.50</td>
<td>1.58</td>
</tr>
<tr>
<td>1</td>
<td>12</td>
<td>BOT</td>
<td>4.43</td>
<td>2</td>
<td>8</td>
<td>18.50</td>
<td>1.58</td>
</tr>
</tbody>
</table>

10.2.6 Middle Strip Steel Disposition

<table>
<thead>
<tr>
<th>Span</th>
<th>ID</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>TOP</td>
<td>ft</td>
<td></td>
<td></td>
<td>8.67</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>TOP</td>
<td>14.33</td>
<td>5</td>
<td>5</td>
<td>4.84</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>TOP</td>
<td>0.00</td>
<td>5</td>
<td>5</td>
<td>9.33</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>TOP</td>
<td>16.66</td>
<td>6</td>
<td>5</td>
<td>10.51</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>6</td>
<td>TOP</td>
<td>0.00</td>
<td>5</td>
<td>5</td>
<td>5.16</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>7</td>
<td>TOP</td>
<td>22.09</td>
<td>6</td>
<td>5</td>
<td>5.08</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>9</td>
<td>BOT</td>
<td>0.00</td>
<td>2</td>
<td>8</td>
<td>16.50</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>12</td>
<td>BOT</td>
<td>0.00</td>
<td>1</td>
<td>8</td>
<td>15.50</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>10</td>
<td>BOT</td>
<td>1.72</td>
<td>2</td>
<td>8</td>
<td>22.50</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>13</td>
<td>BOT</td>
<td>4.43</td>
<td>2</td>
<td>8</td>
<td>18.50</td>
<td></td>
</tr>
</tbody>
</table>

10.3 Base Reinforcement. This section describes base reinforcement as entered by user. These bars will be used for the design and will be reporting the bars in addition to this base reinforcement.

10.3.1 Isolated Bars. This section lists the details of the isolated bars entered as base reinforcement.

<table>
<thead>
<tr>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Quantity</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TOP</td>
<td>.00</td>
<td>4.00</td>
<td>4.00</td>
<td>1.50</td>
<td>3.83</td>
<td>.80</td>
</tr>
<tr>
<td>1</td>
<td>TOP</td>
<td>15.34</td>
<td>4.00</td>
<td>4.00</td>
<td>1.50</td>
<td>9.27</td>
<td>.80</td>
</tr>
<tr>
<td>2</td>
<td>TOP</td>
<td>21.74</td>
<td>4.00</td>
<td>4.00</td>
<td>1.50</td>
<td>9.98</td>
<td>.80</td>
</tr>
<tr>
<td>3</td>
<td>TOP</td>
<td>18.20</td>
<td>4.00</td>
<td>4.00</td>
<td>1.50</td>
<td>5.95</td>
<td>.80</td>
</tr>
</tbody>
</table>

10.3.2 Mesh Reinforcement. This section lists the details of the mesh reinforcement entered as base reinforcement.

<table>
<thead>
<tr>
<th>#</th>
<th>Span</th>
<th>Location</th>
<th>From</th>
<th>Spacing</th>
<th>Size</th>
<th>Cover</th>
<th>Length</th>
<th>Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>BOT</td>
<td>.00</td>
<td>24.00</td>
<td>5</td>
<td>1.50</td>
<td>19.17</td>
<td>2.48</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>BOT</td>
<td>.00</td>
<td>24.00</td>
<td>5</td>
<td>1.50</td>
<td>27.17</td>
<td>2.48</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>BOT</td>
<td>.00</td>
<td>24.00</td>
<td>5</td>
<td>1.50</td>
<td>22.75</td>
<td>2.48</td>
<td></td>
</tr>
</tbody>
</table>
9.3.4.10 Section 11: Mild Steel – Redistributed

This section is the same as Section 10. The only difference is that the values for reinforcement are based on the redistributed moments.

9.3.4.11 Section 12: Shear Reinforcement

Depending on the structural system selected, either a punching shear check (two-way systems) or a one-way shear check (one-way systems) is conducted.

A one-way shear check is conducted for BEAMS and ONE-WAY SLABS.

12.1 Shear Calculation Envelope. Each span is subdivided into 20 equal parts. Shear is checked at each subdivision.

<table>
<thead>
<tr>
<th>SPAN 1</th>
<th>X</th>
<th>d</th>
<th>Vu</th>
<th>Mu</th>
<th>Ratio</th>
<th>Req</th>
<th>Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>X/L</td>
<td>ft</td>
<td>in</td>
<td>k</td>
<td>kft</td>
<td>in2</td>
<td>in</td>
<td></td>
</tr>
<tr>
<td>0.01</td>
<td>0.58</td>
<td>31.69</td>
<td>-91.47</td>
<td>-115.47</td>
<td>1.49</td>
<td>0.22</td>
<td>15.84</td>
</tr>
<tr>
<td>0.05</td>
<td>3.20</td>
<td>30.50</td>
<td>-82.11</td>
<td>113.99</td>
<td>1.39</td>
<td>0.18</td>
<td>15.25</td>
</tr>
<tr>
<td>0.10</td>
<td>6.40</td>
<td>30.50</td>
<td>-70.66</td>
<td>360.79</td>
<td>1.19</td>
<td>0.17</td>
<td>15.25</td>
</tr>
<tr>
<td>0.15</td>
<td>9.60</td>
<td>30.50</td>
<td>-59.20</td>
<td>570.76</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.20</td>
<td>12.80</td>
<td>30.50</td>
<td>-47.75</td>
<td>743.44</td>
<td>0.81</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.25</td>
<td>16.00</td>
<td>30.50</td>
<td>-36.32</td>
<td>879.28</td>
<td>0.61</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.30</td>
<td>19.20</td>
<td>30.50</td>
<td>-24.87</td>
<td>978.21</td>
<td>0.42</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.35</td>
<td>22.40</td>
<td>30.50</td>
<td>-13.40</td>
<td>1040.23</td>
<td>0.23</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.40</td>
<td>25.60</td>
<td>30.50</td>
<td>-1.97</td>
<td>1065.33</td>
<td>0.03</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.45</td>
<td>28.80</td>
<td>30.50</td>
<td>9.49</td>
<td>1052.78</td>
<td>0.16</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.50</td>
<td>32.00</td>
<td>30.50</td>
<td>20.94</td>
<td>1004.05</td>
<td>0.35</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.55</td>
<td>35.20</td>
<td>30.50</td>
<td>32.40</td>
<td>917.68</td>
<td>0.55</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.60</td>
<td>38.39</td>
<td>30.50</td>
<td>43.84</td>
<td>794.38</td>
<td>0.74</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.65</td>
<td>41.60</td>
<td>30.50</td>
<td>55.29</td>
<td>634.18</td>
<td>0.93</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>0.70</td>
<td>44.82</td>
<td>30.50</td>
<td>66.74</td>
<td>437.06</td>
<td>1.13</td>
<td>0.17</td>
<td>15.25</td>
</tr>
<tr>
<td>0.75</td>
<td>48.00</td>
<td>30.50</td>
<td>78.20</td>
<td>202.95</td>
<td>1.32</td>
<td>0.17</td>
<td>15.25</td>
</tr>
<tr>
<td>0.80</td>
<td>51.21</td>
<td>31.69</td>
<td>89.65</td>
<td>-68.33</td>
<td>1.46</td>
<td>0.21</td>
<td>15.84</td>
</tr>
<tr>
<td>0.85</td>
<td>54.40</td>
<td>31.69</td>
<td>101.10</td>
<td>-376.59</td>
<td>1.64</td>
<td>0.29</td>
<td>15.84</td>
</tr>
<tr>
<td>0.90</td>
<td>57.61</td>
<td>31.69</td>
<td>112.54</td>
<td>-721.74</td>
<td>1.83</td>
<td>0.38</td>
<td>15.84</td>
</tr>
<tr>
<td>0.95</td>
<td>60.79</td>
<td>31.69</td>
<td>123.99</td>
<td>-1103.72</td>
<td>2.01</td>
<td>0.46</td>
<td>15.84</td>
</tr>
<tr>
<td>0.99</td>
<td>63.25</td>
<td>31.69</td>
<td>132.74</td>
<td>-1421.92</td>
<td>2.16</td>
<td>0.53</td>
<td>13.93</td>
</tr>
</tbody>
</table>

Note: Sections with **** have exceeded the maximum allowable shear stress.

The first and last points refer to the system line at support (X/L=0 and X/L=1). It is not required by ACI to check the shears at the system line. The first point for which shear is to be checked is recommended to be taken a distance equal to the effective depth, d.
of member from the face-of-support. Hence, the values given for 
X/L=0 and X/L=1 are to be considered as a guideline.

The effective depth d used for stirrup calculations is based on the 
total depth of the section and reinforcement cover.

9.3.4.12 Section 13: Punching Shear Reinforcement

A punching shear check is carried out if the structural system is 
TWO-WAY.

13.1 Critical Section Geometry.

<table>
<thead>
<tr>
<th>Column</th>
<th>Layer</th>
<th>Cond.</th>
<th>a</th>
<th>d</th>
<th>b1</th>
<th>b2</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>1</td>
<td>4.69</td>
<td>9.38</td>
<td>52.37</td>
<td>45.37</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1</td>
<td>8.19</td>
<td>16.38</td>
<td>28.84</td>
<td>28.84</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>1</td>
<td>7.19</td>
<td>14.38</td>
<td>28.38</td>
<td>30.37</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>1</td>
<td>4.44</td>
<td>8.88</td>
<td>38.87</td>
<td>56.87</td>
</tr>
</tbody>
</table>

Layer : The layer of the reinforcement for each column
Cond. : 1 = Interior, 2 = End, 3 = Corner, 4 = Edge
a : The distance between the layer and face of column or drop cap(*)
d : Effective depth
b1 : length of section parallel to span line
b2 : length of section normal to span line

13.2 Critical Section Stresses. The outcome of the punching shear 
analysis is summarized in data column entitled Stress ratio. This is 
the ratio of the calculated punching shear stress to the allowable 
stress. If the stress ratio for any support exceeds 1, punching shear 
reinforcement will be provided. If it exceeds the limits imposed by 
the code the cross section has to be enlarged or has to increase the 
concrete strength.

<table>
<thead>
<tr>
<th>Label</th>
<th>Layer</th>
<th>Cond.</th>
<th>Factored shear k</th>
<th>Factored moment k-ft</th>
<th>Stress due to shear ksi</th>
<th>Stress due to moment ksi</th>
<th>Total stress ksi</th>
<th>Allowable stress ksi</th>
<th>Stress ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>-39.13 -100.00</td>
<td>0.09 0.181</td>
<td>0.270</td>
<td>0.190</td>
<td>1.421</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>3</td>
<td>1</td>
<td>-194.04 -187.88</td>
<td>0.10 0.022</td>
<td>0.117</td>
<td>0.160</td>
<td>0.732</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>1</td>
<td>-206.37 +210.66</td>
<td>0.10 0.025</td>
<td>0.126</td>
<td>0.160</td>
<td>0.787</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>2</td>
<td>-80.02 +100.00</td>
<td>0.18 0.208</td>
<td>0.390</td>
<td>0.190</td>
<td>2.053</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Four location conditions, such as corner column, edge columns, 
etc., are differentiated in the punching shear calculations. These 
conditions are clearly displayed at the top of this data block. From 
the geometry of the problem inputted by the user, ADAPT 
determines which of the conditions is applicable at each support. 
The condition as identified by ADAPT is listed in data column 3.
If ADAPT determines that a punching shear check is not applicable for a support, such as in the case of a wall support, no values will be printed for that joint.

Data columns 4 and 5 are the applicable FACTORED shear and moment at the joints. Calculated stresses due to the factored shears and moments are shown in data columns 6 and 7.

TOTAL stress (column 8) is the sum of stresses due to shear and bending (sum of columns 6 and 7).

13.3 Punching Shear Reinforcement. This section lists required punching shear reinforcement.

<table>
<thead>
<tr>
<th>Col.</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
<th>Dist</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>2.1</td>
<td>4.2</td>
<td>8.4</td>
<td>12.6</td>
<td>16.8</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>***</td>
<td>***</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Dist. = Distance measured from the face of support
Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.

9.3.4.13 Section 14: Deflections

The deflection data block in the report is a summary of the calculations showing only the maximum values obtained for each span.

<table>
<thead>
<tr>
<th>Span</th>
<th>SW</th>
<th>SW+SDL</th>
<th>SW+SDL+Creep</th>
<th>LL</th>
<th>X</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.06</td>
<td>0.17(1334)</td>
<td>0.03(7212)</td>
<td>0.00(****)</td>
<td>0.20(1126)</td>
</tr>
<tr>
<td>2</td>
<td>0.00</td>
<td>0.12</td>
<td>0.37(887)</td>
<td>0.05(6098)</td>
<td>0.00(****)</td>
<td>0.42(775)</td>
</tr>
<tr>
<td>3</td>
<td>0.00</td>
<td>0.13</td>
<td>0.39(698)</td>
<td>0.18(1548)</td>
<td>0.00(****)</td>
<td>0.57(481)</td>
</tr>
<tr>
<td>CR</td>
<td>0.00</td>
<td>-0.07</td>
<td>-0.22(192)</td>
<td>-0.09(475)</td>
<td>0.00(****)</td>
<td>-0.31(137)</td>
</tr>
</tbody>
</table>

The concrete’s modulus of elasticity ($E_c$) used for the deflection calculation is calculated by ADAPT using the concrete strength input by the user and the code formula for normal-weight and light-weight concrete. The user has the option to overwrite the code-based modulus of elasticity and enter his/her choice. This value is reported in data block 1 of the report.
The Creep factor (K) is input by the user. It is the number by which the deflection due to dead load is multiplied to obtain the additional time-dependent deflection.

If the section is cracked, the cracked moment of inertia, I_{effective}, is used in ADAPT for the calculation of deflection. I_{effective} is calculated based on the ACI code procedure.

A negative deflection value indicates deflection upward.

Values in the parentheses are the deflection ratios computed as the length of each span divided by its maximum deflection. Deflection ratios are entered as positive regardless of direction of deflection. If a deflection ratio exceeds 100000, a value equal to 99999 is entered within the parentheses.

Data column 2 (SW) is deflection due only to selfweight. It should be noted that this column of data serves only as background information for the user, for at no time during its function is the slab expected to be subjected to selfweight alone. Under normal conditions at least shoring will be present.

SW+SDL in column 3 is the deflection of the slab due to the user-defined super-imposed dead load with selfweight.

SW+SDL+CREEP in column 4 is the sum of the immediate deflection due to SW and SDL (column 2 & 3) and the deflection due to creep. The deflection due to creep is not applied to the live loading. This column is (1+K) times the deflection due to SW+SDL.

Deflection due to live loading (LL) is listed in column 5.

Deflection due to other loading (X) is listed in column 6.

Finally, the long-term deflection due to dead load, and the immediate live-load deflection and other loading are totaled in the last column (column 7).

9.3.4.14 Section 16: Unbalanced Moment Reinforcement
This section lists the reinforcement required for the unbalanced moment. This is calculated only if the structural system selected is two-way.

### 16.1 Unbalanced Moment Reinforcement - No Redistribution

<table>
<thead>
<tr>
<th>Joint</th>
<th>Gamma Left</th>
<th>Gamma Right</th>
<th>Width Left</th>
<th>Width Right</th>
<th>Moment Left Neg</th>
<th>Moment Left Pos</th>
<th>Moment Right Neg</th>
<th>Moment Right Pos</th>
<th>As Top</th>
<th>As Bot</th>
<th>n Bar Top</th>
<th>n Bar Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>0.00</td>
<td>0.84</td>
<td>0.00</td>
<td>18.00</td>
<td>0.00</td>
<td>-88.00</td>
<td>112.62</td>
<td>1.95</td>
<td>4.56</td>
<td></td>
<td>7</td>
<td>6</td>
</tr>
<tr>
<td>2</td>
<td>0.58</td>
<td>0.58</td>
<td>5.50</td>
<td>5.50</td>
<td>-178.33</td>
<td>0.00</td>
<td>-198.75</td>
<td>0.00</td>
<td>3.14</td>
<td>0.00</td>
<td>11</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>0.58</td>
<td>0.58</td>
<td>5.50</td>
<td>5.50</td>
<td>-185.49</td>
<td>0.00</td>
<td>-194.99</td>
<td>0.00</td>
<td>3.05</td>
<td>0.00</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>0.84</td>
<td>0.84</td>
<td>18.00</td>
<td>18.00</td>
<td>-90.32</td>
<td>83.51</td>
<td>-37.01</td>
<td>0.00</td>
<td>4.45</td>
<td>1.86</td>
<td>15</td>
<td>3</td>
</tr>
</tbody>
</table>

#### 9.3.5 Detailed Report

The detailed report consists of listing of values at 1/20th point along each span. It is the bulk of data from which the summary printout is extracted. As an example, the following illustrates partial listings of moments, shears, rebar etc. Selected detailed results of the analysis and design at 1/20th points along each span may be appended to the comprehensive output using the report setup dialog box. Detailed output for the investigation is available only after the investigation execution is done. All of the detailed output files are written to separate data files with the .DAT extension, and may also be appended to the tabulated output. Examples of each output are provided at the end of this section.

#### 9.3.5.1 Section 23: Detailed Moments

This section shows a detailed listing at 1/20th points in each span for moments.

<table>
<thead>
<tr>
<th>SPAN 1</th>
<th>XL</th>
<th>X</th>
<th>SW</th>
<th>SDL</th>
<th>XL</th>
<th>LL Min</th>
<th>LL Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>25.88</td>
<td>0.00</td>
<td>12.97</td>
<td>12.97</td>
<td></td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>65.24</td>
<td>0.00</td>
<td>32.96</td>
<td>32.96</td>
<td></td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>-166.68</td>
<td>0.00</td>
<td>-70.16</td>
<td>-70.16</td>
<td></td>
</tr>
<tr>
<td>0.15</td>
<td>2.88</td>
<td>0.00</td>
<td>-215.21</td>
<td>0.00</td>
<td>-92.91</td>
<td>-92.91</td>
<td></td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>-267.88</td>
<td>0.00</td>
<td>-117.64</td>
<td>-117.64</td>
<td></td>
</tr>
</tbody>
</table>

#### 9.3.5.2 Section 24: Detailed Shears

This section shows a detailed listing at 1/20th points in each span for shears.
### 9.3.5.3 Section 25: Factored Moments and Reactions

This section lists factored design moments for different load combinations. The envelope of factored moments is shown in Section 8.

Load Combination: 1.20SW + 1.60LL + 1.20SDL + 1.60XL

#### Factored Design Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>18.94</td>
<td>18.94</td>
<td>152.15</td>
<td>152.15</td>
<td>-428.30</td>
<td>-428.30</td>
</tr>
<tr>
<td>2</td>
<td>-441.73</td>
<td>-441.73</td>
<td>208.77</td>
<td>208.77</td>
<td>-504.77</td>
<td>-504.77</td>
</tr>
</tbody>
</table>

#### Reactions and Column Moments

<table>
<thead>
<tr>
<th>Joint</th>
<th>Reaction Max</th>
<th>Reaction Min</th>
<th>Moment Lower Column Max</th>
<th>Moment Lower Column Min</th>
<th>Moment Upper Column Max</th>
<th>Moment Upper Column Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>58.31</td>
<td>58.31</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>221.49</td>
<td>221.49</td>
<td>-12.61</td>
<td>-12.61</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>236.66</td>
<td>236.66</td>
<td>-15.55</td>
<td>-15.55</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Note: Moments are reported at face of support

### 9.3.5.6 Section 26: Factored Lateral Moments

This section list factored design moments for different load combination including lateral loads. The envelope of factored moments is shown in Section 9.

Load Combination: 1.20 SW +1.00 LL +1.20 SDL +1.00 XL +1.00 LAT

#### Factored Lateral Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>+112.62</td>
<td>+112.62</td>
<td>+127.72</td>
<td>+127.72</td>
<td>-461.85</td>
<td>-461.85</td>
</tr>
<tr>
<td>2</td>
<td>-287.30</td>
<td>-287.30</td>
<td>+182.83</td>
<td>+182.83</td>
<td>-533.10</td>
<td>-533.10</td>
</tr>
</tbody>
</table>

Load Combination: 1.20 SW +1.00 LL +1.20 SDL +1.00 XL -1.00 LAT
Factored Lateral Moments (Not Redistributed)

<table>
<thead>
<tr>
<th>Span</th>
<th>Left Max</th>
<th>Left Min</th>
<th>Middle Max</th>
<th>Middle Min</th>
<th>Right Max</th>
<th>Right Min</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
</tr>
<tr>
<td>1</td>
<td>-80.43</td>
<td>-80.43</td>
<td>+127.72</td>
<td>+127.72</td>
<td>-277.50</td>
<td>-277.50</td>
</tr>
</tbody>
</table>

9.3.5.7 Section 29: Detailed Rebar

This section lists for each 1/20th point of spans the computed and the minimum rebar required. It also lists the associated governing values of selected rebar.

### SPAN 1

<table>
<thead>
<tr>
<th>XL</th>
<th>X</th>
<th>Analysis Top</th>
<th>Analysis Bot</th>
<th>Minimum Top</th>
<th>Minimum Bot</th>
<th>Selected Top</th>
<th>Selected Bot</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>in²</td>
<td>in²</td>
<td>in²</td>
<td>k-ft</td>
<td>k-ft</td>
<td>in²</td>
<td>in²</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>2.31</td>
<td>4.56</td>
<td>0.00</td>
<td>3.89</td>
<td>2.31</td>
<td>4.56</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>1.75</td>
<td>4.56</td>
<td>0.00</td>
<td>3.89</td>
<td>1.75</td>
<td>4.56</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.96</td>
<td>4.56</td>
<td>0.00</td>
<td>3.89</td>
<td>0.96</td>
<td>4.56</td>
</tr>
<tr>
<td>0.15</td>
<td>2.88</td>
<td>0.29</td>
<td>4.92</td>
<td>0.00</td>
<td>3.89</td>
<td>0.29</td>
<td>4.92</td>
</tr>
<tr>
<td>0.90</td>
<td>17.25</td>
<td>9.49</td>
<td>0.00</td>
<td>3.89</td>
<td>0.00</td>
<td>9.49</td>
<td>0.00</td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>11.98</td>
<td>0.00</td>
<td>3.89</td>
<td>0.00</td>
<td>11.98</td>
<td>0.00</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>12.61</td>
<td>0.00</td>
<td>3.89</td>
<td>0.00</td>
<td>12.61</td>
<td>0.00</td>
</tr>
</tbody>
</table>

9.3.5.8 Section 30: Punching Shear Reinforcement

Reinforcement option: Stud
Stud diameter: 0.38
Number of rails per side: 2

#### Column - 1

<table>
<thead>
<tr>
<th>Layer</th>
<th>Cond.</th>
<th>a</th>
<th>d</th>
<th>b1</th>
<th>b2</th>
<th>Vu</th>
<th>Mu</th>
<th>Stress</th>
<th>Allow.</th>
<th>Ratio</th>
<th>As</th>
<th>NStuds</th>
<th>Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>k-ft</td>
<td>k-ft</td>
<td>ksi</td>
<td>ksi</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4.19</td>
<td>8.37</td>
<td>16.19</td>
<td>20.37</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.270</td>
<td>0.190</td>
<td>1.42</td>
<td>0.86</td>
<td>2</td>
<td>2.09</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>8.37</td>
<td>8.37</td>
<td>20.37</td>
<td>28.75</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.183</td>
<td>0.190</td>
<td>0.96</td>
<td>0.57</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>12.56</td>
<td>8.37</td>
<td>24.56</td>
<td>37.12</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.136</td>
<td>0.190</td>
<td>0.72</td>
<td>0.33</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>16.75</td>
<td>8.37</td>
<td>28.75</td>
<td>45.50</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.107</td>
<td>0.190</td>
<td>0.56</td>
<td>0.12</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>20.94</td>
<td>8.37</td>
<td>32.94</td>
<td>53.87</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.088</td>
<td>0.190</td>
<td>0.46</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Dist. = Distance between shear studs between layers

Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.

#### Legend (30):

<table>
<thead>
<tr>
<th>Layer</th>
<th>Cond.</th>
<th>a</th>
<th>d</th>
<th>b1</th>
<th>b2</th>
<th>Vu</th>
<th>Mu</th>
<th>Stress</th>
<th>Allow.</th>
<th>Ratio</th>
<th>As</th>
<th>NStuds</th>
<th>Dist.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>in</td>
<td>k-ft</td>
<td>k-ft</td>
<td>ksi</td>
<td>ksi</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>4.19</td>
<td>8.37</td>
<td>16.19</td>
<td>20.37</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.270</td>
<td>0.190</td>
<td>1.42</td>
<td>0.86</td>
<td>2</td>
<td>2.09</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>8.37</td>
<td>8.37</td>
<td>20.37</td>
<td>28.75</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.183</td>
<td>0.190</td>
<td>0.96</td>
<td>0.57</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>12.56</td>
<td>8.37</td>
<td>24.56</td>
<td>37.12</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.136</td>
<td>0.190</td>
<td>0.72</td>
<td>0.33</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>16.75</td>
<td>8.37</td>
<td>28.75</td>
<td>45.50</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.107</td>
<td>0.190</td>
<td>0.56</td>
<td>0.12</td>
<td>1</td>
<td>4.19</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>20.94</td>
<td>8.37</td>
<td>32.94</td>
<td>53.87</td>
<td>-39.13</td>
<td>-100.00</td>
<td>0.088</td>
<td>0.190</td>
<td>0.46</td>
<td>0.00</td>
<td>0</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Dist. = Distance between shear studs between layers

Note: Columns with --- have not been checked for punching shear.
Note: Columns with *** have exceeded the maximum allowable shear stress.

#### Legend (30):

Layer : The layer of the reinforcement for each column
Cond. : 1 = Interior, 2 = End, 3 = Corner, 4 = Edge
a : The distance between the layer and face of column or drop cap(*)
d : Effective depth
b1 : length of section parallel to span line
b2 : length of section normal to span line
Vu : Factored shear
Mu : Factored moment
Stress : Maximum stress
Allow : Allowable stress
9.3.5.9 Section 32: Unbalanced Moment Reinforcement

32.1 Unbalanced Moment Reinforcement - No Redistribution. This table shows unbalanced moments for different load combinations.

| Load Combination: STRENGTH_1 Max LL |
|-----------------|----------------|----------------|----------------|----------------|----------------|----------------|
| Joint           | Gamma Left     | Gamma Right    | Width Left     | Width Right    | Moment Left    | Moment Right   |
|                 | ft             | ft             | k-ft           | k-ft           | in2            | in2            |
| 1               | 0.00           | 0.84           | 0.00           | 18.00          | 0.00           | 18.94          |
| 2               | 0.58           | 0.58           | 5.50           | 5.50           | 0.00           | -12.70         |

32.2 Unbalanced Moment Reinforcement – Redistributed. This table shows unbalanced moments for different load combinations where moments were redistributed.

| Load Combination: STRENGTH_1 Max LL Pos Lat |
|-----------------|----------------|----------------|----------------|----------------|----------------|----------------|
| Joint           | Gamma Left     | Gamma Right    | Width Left     | Width Right    | Moment Left    | Moment Right   |
|                 | ft             | ft             | k-ft           | k-ft           | in2            | in2            |
| 1               | 0.00           | 0.84           | 0.00           | 18.00          | 0.00           | 112.62         |
| 2               | 0.58           | 0.58           | 5.50           | 5.50           | -174.55        | 2.69           |

9.3.5.10 Section 33: Investigation Mode

This section lists the input and output of the investigation analysis.

33.1 Moment Capacity and Demand Moment. This section lists the demand moment and the moment capacity at 1/20th points along each span. Also lists the ratio of the demand moment to moment capacity.

<table>
<thead>
<tr>
<th>SPAN 1</th>
<th>X</th>
<th>Demand Moment Pos</th>
<th>Demand Moment Neg</th>
<th>Demand Capacity Pos</th>
<th>Demand Capacity Neg</th>
<th>Demand/Capacity Pos</th>
<th>Demand/Capacity Neg</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>k-ft</td>
<td>0.080</td>
<td>0.000</td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>18.02</td>
<td>0.00</td>
<td>224.92</td>
<td>-110.56</td>
<td>0.080</td>
<td>0.000</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>51.81</td>
<td>0.00</td>
<td>224.92</td>
<td>-110.56</td>
<td>0.230</td>
<td>0.000</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>95.50</td>
<td>0.00</td>
<td>223.45</td>
<td>-87.97</td>
<td>0.427</td>
<td>0.000</td>
</tr>
<tr>
<td>0.15</td>
<td>2.88</td>
<td>131.00</td>
<td>0.00</td>
<td>221.00</td>
<td>-65.19</td>
<td>0.593</td>
<td>0.000</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
<td>...</td>
</tr>
<tr>
<td>0.90</td>
<td>17.25</td>
<td>0.00</td>
<td>-312.25</td>
<td>229.83</td>
<td>-873.08</td>
<td>0.000</td>
<td>0.358</td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>0.00</td>
<td>-406.92</td>
<td>229.83</td>
<td>-873.08</td>
<td>0.000</td>
<td>0.466</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>0.00</td>
<td>-429.25</td>
<td>229.83</td>
<td>-873.08</td>
<td>0.000</td>
<td>0.492</td>
</tr>
</tbody>
</table>
33.2 Rebar Used in Investigation. This lists the rebar used for the investigation at 1/20th points along each span. User can choose the rebar from provided or from required or can edit manually for the investigation.

<table>
<thead>
<tr>
<th>X/L</th>
<th>X</th>
<th>Top Rebar</th>
<th>Bot Rebar</th>
</tr>
</thead>
<tbody>
<tr>
<td>ft</td>
<td>in²</td>
<td>in²</td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>3.89</td>
</tr>
<tr>
<td>0.05</td>
<td>0.96</td>
<td>0.00</td>
<td>3.89</td>
</tr>
<tr>
<td>0.10</td>
<td>1.92</td>
<td>0.00</td>
<td>3.89</td>
</tr>
<tr>
<td>0.15</td>
<td>2.88</td>
<td>0.00</td>
<td>3.89</td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.85</td>
<td>16.30</td>
<td>4.29</td>
<td>0.00</td>
</tr>
<tr>
<td>0.90</td>
<td>17.25</td>
<td>6.63</td>
<td>0.00</td>
</tr>
<tr>
<td>0.95</td>
<td>18.21</td>
<td>9.13</td>
<td>0.00</td>
</tr>
<tr>
<td>1.00</td>
<td>19.17</td>
<td>9.73</td>
<td>0.00</td>
</tr>
</tbody>
</table>

9.3.6 Graphical Report

The graphical display includes print-plots of critical information, such as deflections, moments, forces and reinforcement. Each curve in a display, at user’s request, is identified with a different symbol.

9.3.6.1 Deflection

![Deflection Diagrams](File: Mnl5-2)

DEFLECTION

9.3.6.2 Load Cases

LOAD CASE: Super Imposed Dead Load
LOAD CASE: Live Load

Moment Diagrams (No Redistribution)

Shear Diagrams

Deflection Diagrams
LOAD COMBINATION: SERVICE_1_Max_LL

Moment Diagrams
Project: “THREE SPAN TWO-WAY SLAB” / Load Case: SERVICE_1_Max_LL
+1.00 SW +1.00 LL_Max +0.00 SDL +0.00 XL +0.00 LAT
Moment Drawn on Tension Side

DESIGN MOMENT
(Moment is drawn on tension side)

Rebar Diagrams
Project: “THREE SPAN TWO-WAY SLAB” / Load Case: SERVICE_1_Max_LL
+1.00 SW +1.00 LL_Max +0.00 SDL +0.00 XL +0.00 LAT
Rebar [in²]
REINFORCEMENT
REQUIRED AND PROVIDED
LOAD COMBINATION: STRENGTH_1_Max_LL

Moment Diagrams
Project: “THREE SPAN TWO-WAY SLAB” / Load Case: STRENGTH_1_Max_LL
+1.20 SW +1.60 LL_Max +1.20 SDL +1.60 XL +0.00 LAT
Moment Drawn on Tension Side

DESIGN MOMENT
(Moment is drawn on tension side)

Rebar Diagrams
Project: “THREE SPAN TWO-WAY SLAB” / Load Case: STRENGTH_1_Max_LL
+1.20 SW +1.60 LL_Max +1.20 SDL +1.60 XL +0.00 LAT
Rebar Required Top
Rebar Required Bottom
Rebar Provided Top
Rebar Provided Bottom

REINFORCEMENT REQUIRED AND PROVIDED